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r?¹b?I?ð

 ¨…QAM�«  WOF�«Ë  v�≈  bM²�*«   ¨W�U(«   «—Ëd{  s�  lÐUM�«  wLKF�«  w½öIF�«  qšb*«  t½QÐ  ÍuÐd²�«  Õö�ù«  nB²¹
 WOMOD�KH�«  WO�uB)«  …U�U×�  w�  wMOD�KH�«  wLOKF²�«  ÂUEMK�  …—uD*«  WOMÞu�«  W¹ƒd�«  vKŽ  fJF½«  Íc�«  d�_«
 ‰öš s� ¨Êu½UI�« W�Ëœ ¡UMÐ w� W�—UA*«Ë WMÞ«u*« ÂuNH� “eFð rO� ¡UÝ—≈ vKŽ qLF�«Ë ¨WOŽUL²łô«  UłUO²Šô«Ë
 WžUO�  w�  rN�¹Ë  ¨UNð«Ëœ√Ë  UN³O�«dð  wF¹Ë  ¨UNF�  sÞ«u*«  qŽUH²¹  ¨ U³ł«u�«Ë  ‚uI(«  vKŽ  rzU�  wŽUL²ł«  bIŽ

   Æ·«b¼_«Ë  U¹UG�« oOI×²� u½d¹Ë ¨w½U�_« f�ö¹Ë ¨‰U�ü« oI×¹ Õö�≈ Z�U½dÐ

 WDš sL{  ¡Uł bI� ¨tLO¼UH�Ë ÁbŽ«u� t� Î ULKŽ UNH�uÐ ¨ÍuÐd²�« bNA*« d¹uDð w� WOÐd²�« …«œ√ Z¼UM*« X½U� U*Ë
 ¨—«b²�« qJÐ WOŽuM�«  U¹b% “ËU& w� rN�¹ U0 ¨UN³½«uł lOL−Ð WOLKF²�« WOLOKF²�« WOKLF�« ÊU�—√ X'UŽ WK�UJ²�
 sŽ  Y×³�«Ë  W*uF�«  5Ð  X²A²�«  WO�UJýSÐ  ◊—u²�«  ÊËœ  ¨W�dF*«  dBŽ   U³KD²�  WNł«u�  vKŽ  —œU�  qO'  œ«bŽù«Ë
 WO¼U�d�UÐ rFM¹Ë ¨W�«bŽË WO½U�½≈ d¦�√ tO� gOF�« ÊuJ¹ r�UŽ w� WKŽUH�« W�—UA*« v�≈ ‰UI²½ô«Ë ¨¡UL²½ô«Ë W�U�_«

   ÆtLEF½Ë tKL×½ sÞË w�

 b¹bF� ÌŸ«Ë —UC×²ÝUÐË ¨UNłU²½≈ s� ÊuJ¹ Ê√ V−¹ U* Îôu�Ë ¨W�dF*« wÒIKð WOD/ “ËU& vKŽ ’d(« oKDM� s�Ë
 WOMOD�KH�«  Z¼UM*«  d¹uDð  ¡Uł  ¨…U Òšu²*«  WÒ¹dJH�«Ë  WO�dF*«  WOM³K�Ë  ¨b¹d½  Íc�«  V�UDK�  UM²¹ƒ—  rJ%  w²�«   UIKDM*«
 WO³KðË ¨UOłu�uMJ²�«Ë ¨W�UI¦�«Ë ¨rKF�«Ë ¨rOIK� pK²2 wMOD�K� lL²−� v�≈ ‰u�u�« t�«u� —UÞSÐ W�uJ×� W¹ƒ— o�Ë
  U¹UG�«Ë  ·«b¼_«  5Ð ržUM²�«  ôu�  ÊuJO�  t�  ÊU�  U�  u¼Ë ¨WF�«Ë  WIOIŠ W¹ƒd�«  Ác¼ oOI% qF−Ð WKOHJ�«   U³KD²*«

ÆÎ U¹dJ�Ë ÎU¹uÐdðË ÎUO�dF� »uKD*« oI% WHO�uð sŽ Î «dO³Fð ÃU²M�« ÊuJO� ªXK�UJðË XH�Pð bI� ¨ UOFłd*«Ë  UIKDM*«Ë

 Ê“«u²� ªfOÝQ²�« w� ‰u�Q*« U¼—Ëœ ÃUNM*« s� … Ò—dI*« V²J�« WOzeł cš√ “ÒeF¹ U0 ¨d¹uD²�« «cN� d ÒÞRð  UOFłd� WÒLŁ
 w�Ë ¨UNO�≈ œUM²Ýô« - w²�«  UOFłd*«  ¡Uł —UÞù« «c¼ w�Ë Î̈UOMÞËË Î̈U¹dJ�Ë Î̈UO�dF� »uKD*« 5Ð ‚ Òöš wŽ«bÐ≈
 ¨bN'« t Òłu²� ª‰Ë_« wMÞu�« ÃUNM*« WIOŁË v�≈ W�U{ùUÐ ¨wMOD�KH�« wÝUÝ_« Êu½UI�«Ë ‰öI²Ýô« WIOŁË UN²FOKÞ

Æ Ułd�*« qL−� vKŽ UNð«– fJFðË

 ¨oO�b²�«Ë ¨WFł«d*«Ë nO�Q²�« ‚d� s� ªUNFOLł WK�UF�« r�«uDK� dJA�« ¡Uł“≈ ËbG¹ ¨bN'« s� WKŠd*« Ác¼ “U$≈ l�Ë
 ÊuIŁ«Ë s×½Ë ¨d¹uD²�« sŽ Y¹b(« WKŠd� U½“ËU& bI� ¨t1bIð sJ1 U� q�√ UOKF�« WM−K�Ë ¨rOLB²�«Ë ¨·«dýù«Ë

     ÆqLF�« s� W�U(« Ác¼ q�«uð s�

 rOKF²�«Ë WOÐd²�« …—«“Ë

WOMOD�KH�« Z¼UM*« e�d�

Â ≤∞±∏ Ø »¬
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 sOFLł« t³×�Ë t�« vKŽË bL×� U½bOÝ¨ sOKÝdL�«Ë oK��« ·dý« vKŽ Âö��«Ë ÁöB�«Ë ÆÆ sOL�UF�«  »—  tK� bL×�«
 nB�« t³KÞ UMzUMÐô wŽUMB�« rÝd�« w� w½U¦�« qBHK� ¨ l{«u²L�« »U²J�« «c¼ ÂbI½ ≠qłË eŽ≠ tK�«  s� oO�u²Ð ¨bFÐË
 WOL¼√ UN� UL� …œUL�« Ác¼ ΔœU³�Ë  UOÝUÝ« rN� w� rN� U½uŽ ÊuJ¹ Ê«≠qłË eŽ≠v�uL�« sOKzUÝ ¨ wŽUMB�« dAŽ ÍœU×�«
 bK³�«  «cNÐ  «uCNMO�  ¨wMI²�«  ÂbI²�«Ë  ÃU²½ô«Ë  tŽUMB�«  o¹dÞ  t¹«bÐ  vKŽ  rNFC¹Ë  ¨włu�uMJ²�«Ë  wŽUMB�«  ‰U−L�«  w�

Æ÷—ô« ŸUIÐ v²ý w� oKDML�« włu�uMJ²�« ÂbI²�« V�— v�« ÁuKIM¹Ë ¨VO³×�«
 UL� ¨ —uEMLK� Áb�UF²L�« j�U�L�« rÝ—Ë ÍœuLF�« ◊UIÝô«  UOÝUÝ√ »U²J�« «c¼ s� v�Ëô« ÁbŠu�« w� UMł—œ« b�Ë
 vM�²O� s¹—UL²�«Ë tK¦�ô« s� dO¦J�UÐ ÁbŠu�« Ác¼ UM¹dŁ« b�Ë¨ tOM×ML�«Ë tKzUL�«Ë Áb�UF²L�« `DÝô« Ÿ«u½« nK²�� X�ËUMð

 Æd�¹Ë t�uN�Ð UNðUÞUIÝ« œU−¹«Ë ¨dOþUML�« —uB²� tLN� bO�U²� tO�UJ�« t�dH�« V�UDK�
 tłU×�« —dJ²ðË «bOH�Ë U³ÝUM� ÁUM¹«— U� UNM� U½d²š« b�Ë ¨ UNKO¦Lð tOHO�Ë  UŽUDI�« Ÿu{u� XMLCð tO½U¦�« ÁbŠu�«

ÆÃU²½ô«Ë tŽUMB�« ‰U−� w� t�œUI�«  UIO³D²�« w� tO�«
 dONA�« œU�uðËô« Z�U½dÐ UNO� UM�b�²Ý« b�Ë¨»uÝU×�« tDÝ«uÐ rÝd�« UM�ËUMð bI� ÁdOšô«Ë t¦�U¦�« ÁbŠu�« w�Ë
 œ—Ë U� tLłdðË t¹eOK−½ô« Z�U½d³�« tG� —U³²Žô« sOFÐ s¹cš« —u�O�Ë fKÝ qJAÐ ÁœUL�« ÷dFÐ UML�Ë ¨≤∞±≥ tF³Þ
 rNðU¹u²�LÐ t³KD�« sOJLð qł« s� tHK²�L�« s¹—UL²�«Ë tK¦�ôUÐ tŠËdDL�« —UJ�ô« UM¹dŁ« UL� ¨tOÐdF�« tGK� ÊUF� s� UNO�

Æ Z�U½d³�« «c¼ s� ÁœUH²Ýô« tHK²�L�«
∫wK¹U� »U²J�« «c¼ œ«bŽ« w� UMOŽ«— b�Ë

bOł qJAÐ ÁœUL�« s� t³KD�« sJL²¹ w� tO�U�Ë t³ÝUM� tK¦�« —UO²š«  ≠
 UN�OÝdðË  U�uKFL�« XO³¦²� ¨UN−zU²½ sŽ rN�H½« w�  özU�²�« iFÐ dO¦ð b� w²�« tDA½ô« iF³Ð t³KD�« ÂUO�  ≠

Æ tOLOKF²�« ÁœUL�UÐ tDA½ô« s� tBK�²�L�« ZzU²M�«  jÐ—Ë ¨ t³KD�« s¼– w�
∫ wK¹ U� »U²J�« «cN� rN�¹—bð w� «uŽ«d¹ Ê« sOLKFL�« UMðuš« s� ułd½ UL�

Æ »U²J�« w� UL� ÁœUL�« ¡UDŽ« w� q�K�²�« ≠
ÆwHB�« qŽUH²�«Ë t³KD�« ”ULŠ Á—UŁ«Ë ¨ UN²FÐU²�Ë tO²O³�«  U³ł«u�« vKŽ eO�d²�« ≠

Æ qO�²�« vKŽ t³KD�« Á—b� ÁœU¹“ qł« s� tOLOKF²�« qzUÝu�« Â«b�²Ý« ≠
 b� ÊuJ½ Ê« sOK�« ¨ »U²J�« «c¼ f¹—bð bMŽ rNz«—«Ë rNðUEŠöLÐ UMOKŽ «uK�³¹ ô Ê« sOLKFL�« UMzö�“ s� ułd½ UL�

Æ ÁbOH�Ë tF²L�Ë  tKNÝ t²Ý«—œ ÊuJð Ê«Ë¨ l{«u²L�« qLF�« «c¼ r¹bIð w� UMI�Ë
bBI�« ¡«—Ë s� tK�«Ë

nO�Q²�« o¹d�

W?�b?I?�
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…b�UF²L�« j�U�L�« rÝ—
≥  j�U�L�« rÝ—
≤∞  ÂU�ł_« j�U�� vKŽ WK¦�√
≥≤  s¹—ULð

 U???ŽU???DI�« r???????Ý—
¥∞  ŸUDI�« vMF�
¥≤  q�UJ�« ŸUDI�«
¥≥   ŸUDI�« nB½
¥μ  UN²�ôœË lDI�« ◊uDš
¥μ  ©dOAN²�«® qOKE²�« ◊uDš
μ≤  s¹—ULð

 œU�uðË_UÐ rÝd�«
∂±  œU�uðË_« qOGAð   ∫‰Ë_« ”—b�«
∑±  oO�b�« rÝd�«   ∫w½U¦�« ”—b�«
∏≤  rÝd�« w� —U×Ðô«   ∫Y�U¦�« ”—b�«
∑π  tðU¹u²×�Ë rÝd�«  «Ëœ√ j¹dý   ∫lÐ«d�« ”—b�«

 π∂   q¹bF²�«  «Ëœ√ j¹dý   ∫f�U��« ”—b�«
±±∞   UMzUJ�« hzUBš  «Ëœ√ j¹dý   ∫”œU��« ”—b�«
±±≤  s¹bF³Ð rÝ— W�—Ë vKŽ Íd²�Ëe¹_« rÝd�«   ∫lÐU��« ”—b�«
±≤μ   UL�−L�« rÝ—   ∫s�U¦�« ”—b�«
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≤

±±…b?????Šu�«…b�UF²*« j�U�*« rÝ—

 v�Ë_« …bŠu�« ·«b¼√
 ÆtKO¦9 WOHO�Ë ¨⁄«dH�« w� ÍœuLF�« ◊UIÝù« ÂuNH� vKŽ ·dF²�«   

ÆUNOKŽ ◊UIÝù« WOHO�Ë ¨WOÝUÝ_« WŁö¦�«  U¹u²�*« W�dF�   
  Už«dH�«  ”UO�Ë ¨rÝd�«  WŠu�  vKŽ WŁö¦�«  j�U�*«  VOðdð  W�dF�    

Æg�«uN�« 5ÐË UNMOÐ
 ¨W¹œuLF�« ∫UNŠuDÝ Ÿ«u½√ v²AÐ dOþUMLK� WŁö¦�« j�U�*« rÝ— ÊUIð≈    

ÆWOM×M*«Ë ¨WKzU*«Ë
 ¨j�U�*«  l¹“uð  YOŠ s� WK�UJ²�  wŽUM� rÝ— WŠu�  rÝ— ÊUIð≈    

 ÆWLOK��« ‚dD�UÐ UNOKŽ œUFÐ_« WÐU²�Ë
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j�U�L�« rÝ—
 Í√ jIÝ qFH�« s� o²A� rÝ« u¼Ë ¨◊uI��« ÊUJ� vKŽ ‰b¹ qFH� Ê“Ë vKŽ ÊUJ� rÝ« u¼ ∫WG� jI�L�«

ÆÂU�łú� W¹œuLF�« j�U�L�« WÝ«—bÐ wH²JMÝ »U³�« «c¼ w�Ë Æ÷—_« vKŽ l�Ë
 vKŽ r�−� s� ÍœuLŽ qJAÐ WD�UÝ WLOI²�� WFý√ ◊UIÝ« s� Z²M¹ Íc�« dŁ_« u¼ ∫ÎUŠöD�« jI�L�«Ë

ÆsOF� Èu²��
ÆÍœuLF�« ◊UIÝù« UM¼ bL²FMÝË ¨ÎU¹“«u²� Ë√ ÎU¹e�d� ÊuJ¹ Ê√ sJL¹ wÝbMN�« ◊UIÝù«Ë

∫ÍœuLF�« ◊UIÝù«  

Ær�−�« sŽ WK�U� …dJ� wDFð UNŽuL−� w� w²�«Ë ÂU�ł_« j�U�� vKŽ ‰uB×K� WF³²L�« vK¦L�« WI¹dD�« w¼
 wDGð WŽuM²� s¹—ULðË WK¦�√ vKŽ qL²Að w²�«Ë WOÝUÝ_« wÝbMN�« ◊UIÝù« ΔœU³� UM¼ w�UFð t½–SÐ ”—b²Ý
 rÝ— pM� VKD²ð   UŠu� cOHMðË wÝbMN�«  ◊UIÝô« ÂuNH� rN�  vKŽ …—bI�«  pODFð  WK�Uý …—uBÐ Ÿu{uL�«
 ÁcN� WKB×L� UNOKŽ œUFÐ_« l{ËË rÝd�« WŠu� vKŽ UNF¹“uð l� W³�d�Ë WDO�Ð WHK²�� dOþUML� WŁö¦�« j�U�L�«

ÆW�UN�« …bŠu�«
 ¨WDIM�« j�U�L� Ÿu{uL�« «c¼  UOÝUÝ√ w� oO�b�« q�K�²�«Ë WK¦�_« s� —U¦�ù« …bŠu�« Ác¼ w� UMOŽ«—
 W³KD�«  Èb�  ÂUŽ  nF{ s� WIÐU��«   «uM��«  w�  ÁUMEŠô UL�  Ær�−L�«  ¨Íu²�L�«  `D��«  ¨rOI²�L�«  j��«
 …œUŽ≈ V�UD�« s� »uKD� dOž WK¦�_« w� ÕËdDL�« q�K�²�« ÆwÝbMN�« ◊UIÝù« rO¼UH� rN� w� rN¹b� WÐuF�Ë

  ÆtLO¼UH� aOÝdðË Ÿu{uLK� »öD�« rN� qON�²� WOFłdL� Ád³²F½ UL½≈Ë tLÝ—
 w� ◊UIÝù« sŽ …ełu� W×L� wDFMÝË ¨v�Ë_« W¹Ë«e�« w� ◊UIÝù« vKŽ Ÿu{uL�« ÕdÞ w� UM¼ bL²FMÝ
 Ë√ WFÐ—√ rÝ— ÊUJ�ùUÐ t½√ rKF�« l� WHK²�L�«  UL�−LK� j�U�� WŁöŁ rÝdÐ UM¼ wH²JMÝ UL� ¨W¦�U¦�« W¹Ë«e�«
 jI�� rÝdÐ wH²J½ ULÐd� ¨r�−�« Áœb×¹ j�U�L�« œbF� Æ UL�−L�« Ác¼ t³KD²ð U� V�Š j�U�� W²Ý Ë√ W�Lš
 iFÐ w�Ë ¨W½«uDÝ_U� sOMŁ« sODI�� Ë√ ¨VFJL�« Ë√ ¨…dJ�« q¦� tMŽ WK�U� …dJ� UMODF¹ Íc�« r�−LK� bŠ«Ë
 …dJ� wDFð W�Uš bŽ«u� UN�  U�uÝd�« s� WŽuL−� w¼ W¹UNM�« w� j�U�L�U� ¨j�U�� …bŽ rÝ— ÂeK¹  ôU×�«

ÆWOzd� dOž WOKš«œ Ë√ …d¼Uþ Èdš√ qO�UHð W¹√Ë ŸUHð—ô«Ë ÷dF�«Ë ‰uD�U� r�−�« sŽ WK�U�

≥
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 ¨´± jI�L�« UNMŽ Z²½ ¥ ¨≥ ¨≤ ¨± r�−K� ◊UIÝù« Èu²�� vKŽ W¹œuLŽ WFý_ ÎôU¦� ©±® qJA�« sO³¹
Ær�−K� wIOI×�« bF³�UÐ ◊UIÝù« Èu²�� vKŽ ´≥ ¨´≤ ¨´¥

12

3 4

1'

4'3'

2'

©±® qJA�«

Æ◊UIÝù« s� ŸuM�« «c¼ `{uð WK¦�√ ©≤® qJA�« sO³¹Ë
 ∫WŁö¦�«  ◊UIÝù«   U¹u²��  vKŽ  W¹œuLŽ  WFý_«  d³²F½  UM¼  ÁbL²FMÝ  Íc??�«  ◊UIÝù«  s�  ŸuM�«  «c¼  w�Ë
 qš«œ  Ÿu{uL�«  r�−K�  wI�_«Ë  w³½U−�«Ë  w�U�_«  WŁö¦�«  j�U�L�«  UNMŽ  Z²MO�  ¨wI�_«  ¨w³½U−�«  ¨w�U�_«

Æ U¹u²�L�« WŠu�

¥
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©≤® qJA�«

 YOŠ ¨ U¹u²�L�« WŠu� sO³¹ ©≥® qJA�«Ë
©w�U�_«® wÝ√d�« Èu²�L�« v�≈ dOA¹ — ·d×�«   

w³½U−�« Èu²�L�« v�≈ dOA¹ Ã ·d×�«   
 wI�_« Èu²�L�« v�≈ dOA¹ · ·d×�«   

90 90

90

ج
ر

ف
©≥® qJA�«

μ
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 YO×Ð WŠuK�« Ác¼ `²Hð  U¹u²�L�« WŠu� vKŽ WOÝbMN�« ‰UJýú� WŁö¦�« j�U�LK� ◊UIÝù« WOKLŽ ÂULð≈ bFÐ
Æ©¥® qJý w� sO³� u¼ UL� ÎU¹uÝ UN²Ý«—œË j�U�L�« …¡«d� qN�O� bŠ«Ë Èu²�� w� WŁö¦�«  U¹u²�L�« `³Bð

رج

ف

©¥® qJA�«

Æ©μ® qJA�« w� UL� j�U�L�« dNEð rÝd�« W�—Ë vKŽ

©μ® qJA�«

∂
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WDIM�« j�U��  
 Æ©∂® qJA�« w� WMO³L�«  U¹u²�L�« WŠu� w� lIð Â WDIM�« Ê√ ÷dH½

م

مَ

مَ

مَ

ج
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rOI²�*« j)« j�U��  
 Æt²�ULÝ qLN½Ë ¨jI� t�uÞ —U³²ŽUÐ wH²J½ tD�U��Ë j��« rÝ— w�

 Î«–≈ ©j��« w�dÞ® tOKŽ WDI½ dš¬Ë WDI½ ‰ËQÐ œb×¹Ë ¨jIM�« s� Î«bł …dO³� WŽuL−� sŽ …—U³Ž j��« Ê√ ULÐ
Æj��« ‰uÞ w¼ W�U�� ULNMOÐ ⁄«dH�« w� sO²Žu{u� sO²DI½ ◊UIÝù« w� Á—U³²Ž« sJL¹

∫v�Ë_« W�U(«  
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∫WO½U¦�« W�U(«  
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 rŁ ¨qHIL�« `D��« ÊuJð ◊uDš …bŽ s� ÎU½uJ� `D��« —U³²Ž« w¼ ÕuD��« j�U�� rÝd� W�UF�« …bŽUI�«
 q¦Lð w²�« ◊UIM�« ◊UIÝ« Ë√® …œuAML�« `D��« j�U�� v�≈ qB½ UND�U�� qO�uð bFÐË Æ◊uD��« Ác¼ ◊UIÝ≈

ÆUM¼ ÕuD��« W�ULÝ ‰UL¼≈ l� Æ©jIM�« Ác¼ j�U�� qO�uð rŁ s�Ë `D��« ÊU�—√
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∫v�Ë_« W�U(«  

 Æs¹dšü« sO¹u²�L�« vKŽ ÎU¹œuLŽ ÊuJ¹Ë ◊UIÝù«  U¹u²�� ÈbŠ√ Í“«u¹ YO×Ð ⁄«dH�« w� Íu²�L�« `D��« l{Ë «–≈
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 Æ©±μ® qJý w�  U¹u²�*« WŠu� œ«dH½« ‰UŠ w� tD�U��
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∫WO½U¦�« W�U(«  
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∫W¦�U¦�« W�U(«  

 ÆÌu²�� `DÝ sŽ …—U³Ž UNM� Ïq� WŁö¦�« tD�U�L� WŁö¦�«  U¹u²�L�« vKŽ ÎözU� ⁄«dH�« w� `D��« l{Ë ÊU� «–≈
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 v�≈ j)« «c¼ rO�Ið sJLO� tD�U�� œU−¹≈ »uKD� `DÝ w� Ìs×M� Ïjš błË «–≈    ∫WEŠö�
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jI� ŸöÞû�       ©Third Angle Projection® W¦�U¦�« W¹Ë«e�« ◊UIÝ≈  
 cš√ WŽUD²ÝôUÐË ¨wI�√ Èu²�� vKŽ X³¦� t½Q�Ë ◊UIÝù«  U¹u²�� s� W¦�U¦�« W¹Ë«e�« w� r�−�« l{u¹
 `D��« sŽ W�JFML�« WFý_« sŽ …—U³Ž wN� W�U×�« Ác¼ w� ÊuJ²ð w²�« j�U�L�« U�√ Æ U¼U−ðô« W�U� s� tD�U��
 ◊UIÝù« Èu²�� vKŽ `D�K� wzdL�« qE�« ÊuJ²� fJFMðË r�−�« `DÝ vKŽ jI�ð sOF�« WFý√ Ê√ Í√ ¨wzdL�«

Æ©≤∞® qJý ¨qÐUIL�« ◊UIÝù« Èu²�� vKŽ fO�Ë —ËU−L�«
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ÂU�ł_« j�U��   
 WDO�³�« ÂU�ł_« s� U¼«d½ w²�«  UŽuMBL�« lOLłË ¨WO½bFL�«  PAML�«Ë …eNł_«Ë  UM�UL�«Ë  ôü« ¡«eł√ ÊuJ²ð

Æ©≤±® qJý Æ◊Ëd�L�«Ë ¨VFJL�« ¨ÂdN�« ¨—uAML�« ¨W½«uDÝ_« ¨…dJ�« w¼ WOÝUÝ_« ÂU�ł_«Ë ÆUNðUI²A�Ë
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©≤≤® qJA�«

±∏

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



ÆtD�U�� l�«u�Ë  U¹u²�L�« WŠu� qš«œ ⁄«dH�« w� ÎUŽu{u� ©ÎUL�−�® ÎUOÝbM¼ Î«—uEM� ©≤≥® qJA�« sO³¹
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 ÂU�ł_« j�U�� vKŽ WK¦�√

ÆWŁö¦�« tD�U��Ë  öOD²�� Í“«u²�   ∫©±® ‰U¦�
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ÆWŁö¦�« tD�U��Ë wŁöŁ —uAM�   ∫©≤® ‰U¦�
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 ÆWŁö¦�« tD�U��Ë ¨XLB� wŁöŁ ÂdN� wÝbM¼ —uEM�    ∫©≥® ‰U¦�
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ÆWŁö¦�« tD�U��Ë ◊Ëd�* wÝbM¼ —uEM�    ∫©¥® ‰U¦�
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ÆWŁö¦�« UND�U��Ë WLzU� W½«uDÝô wÝbM¼ —uEM�    ∫©μ® ‰U¦�
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ÆWŁö¦�« tD�U��Ë wÝ«bÝ —uAM�    ∫©∂® ‰U¦�
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 ÆWŁö¦�« tD�U��Ë …bŽUI�« wÝ«bÝ ÂdN� wÝbM¼ —uEM�     ∫©∑® ‰U¦�
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 ÆWŁö¦�« tD�U��Ë WOJO½UJO� WFDI� wÝbM¼ —uEM�     ∫©∏® ‰U¦�
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 ÆWŁö¦�« tD�U��Ë WOJO½UJO� WFDI� wÝbM¼ —uEM�     ∫©π® ‰U¦�

≤∏

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



jI� ŸöÞû�

 l�«u�« w� sJ�Ë ¨ÂU�łú� j�U�� WŁöŁ rÝ— v�≈ UM�dDð WIÐU��« WK¦�_« lOLł w�   ∫WEŠö�
  ÆWOðü« ‰UJý_« 5³ð UL� j�U�� W²Ý rÝ— sJ1

≤π

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



∫rÝd�« t�—Ë vKŽ j�U�*« l¹“uð  
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 ∫tŁö¦�« tD�U��Ë tOJO½UJO� tFDI� wÝbM¼ —uEM�     ∫©±∞® ‰U¦�
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…bŠu�« ·«b¼√
ÆrÝd�« w� t²OL¼√Ë ŸUDI�« vMF� vKŽ ·dF²�«  

ÆWHK²�*«  UŽUDI�« Ÿ«u½√ r¼√ vKŽ ·dF²�«  
ÆqOKE²�« ◊uDšË lDI�« ◊uDš rÝ— s� sJL²�«  
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∫W�bI�
 ∫UNL¼√Ë ¨ÂU�ł_« qO¦Lð ‚dÞ iFÐ WIÐU��«  «bŠu�« w� XLKFð

 …d¼UE�« ·«u(« rÝdð YOŠ ¨WOł—U)« ÕuD��« `{u¹ rÝ— u¼Ë ©—uEM*« rÝ—® Íd¹uB²�«  rÝd�«  ±
Æ©±Ã ≤ …bŠË® U¼dOžË ·«u(«Ë n¹ËU−²�«Ë »uI¦�« s� WOH�*« ¡«eł_« tO� qLNðË ¨WOzd� ◊uD�Ð

 ¨WOzd� ◊uD�Ð …d¼UE�« ·«u(«Ë ÕuD��« tO� q¦9 rÝ— u¼Ë ©j�U�*« rÝ—® ‰UJý_« œbF²� rÝd�«  ≤
Æ©≤Ã ± …bŠË® WFDI²� ◊uD�Ð ·«u(«Ë n¹ËU−²�«Ë »uI¦K� WOH�*« ¡«eł_« q¦9 UL�

©±® qJA�«

 w� W�Uš UNJÐUAðË j�U�L�« w� WFDI²L�« ◊uD��« kŠô® ÆWŁö¦�« tD�U��Ë —uEML� ÔULÝ— sO³¹ ©±® qJA�«
 »uIŁ s� t¹u²×¹ U�Ë wKš«b�« r�−�« s¹uJð —UNþù ÊUOŠ_« VKž√ w� WłU×�« uŽbð p�c� Æ©w³½U−�« jI�L�«
 WO³½UłË WOI�√Ë WO�U�√  U¹u²�LÐ VÝUM� ÊUJ� w� ÂU�ł_« Ác¼ lD� qO�ð Í—ËdC�« s� ÊU� «c� Æn¹ËU−ðË

Æ©W�U��«  ôU×�« iFÐ w� WKzU� Ë√®

≥π

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



ŸUDI�« vMF�
ÆlDI�« Èu²�� tO� dNE¹ Îö�U� Î«—uEM� sO³¹ ©≤® qJA�«

 WNł s� V¹dI�« ¡e−�« œUFÐ≈Ë r�−�« lD� qO�²Ð WŁö¦�« j�U�L�« sL{ ŸUDI�« rÝ— r²¹ t½√ …—Uýù« —b−ðË
Æ Èdš_« j�U�L�« w� bF³L�« ¡e−�« rÝ— ‰UL¼≈ ÁUMF� fO� «c¼Ë ¨dþUM�«

ÆtM� V¹dI�« w�U�_« ¡e−�« œUFÐ≈ bFÐ ÎUŽuDI� r�−�« s� wHK��« ¡e−K� Î«—uEM� UC¹√ ©≥® qJA�« sO³¹ UL�

©w�U�√® lDI�« Èu²��

©≥® qJA�« ©≤® qJA�«

 ŸuDIL�«  ¡e−�«  rÝ—  qLN¹  r�®  ÆsOK�U�  wI�_«Ë  w³½U−�«  sODI�L�«Ë  w�U�_«  ŸUDI�«  ©¥®  qJA�«  sO³¹
ÆwI�_«Ë w³½U−�« sODI�L�« rÝ— w� ©bF³L�«

√√

√ ≠ √

©¥® qJA�«

¥∞
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Æw³½U−�« lDI�« Èu²�� tO� dNE¹Ë Îö�U� —uEML�« ©μ® qJA�« sO³¹ UL�
ÆtM� V¹dI�« w³½U−�« ¡e−�« œUFÐ≈ bFÐ UŽuDI� —uEML�« ©∂® qJA�« sOÐË

©w³½Uł® lDI�« Èu²��

©∂® qJA�« ©μ® qJA�«

ÆwI�_« ŸUDI�« w� «cJ¼Ë ÆsOK�U� wI�_«Ë w�U�_« sODI�L�«Ë w³½U−�« ŸUDI�« sO³¹ ©∑® qJA�«

»

»
» ≠ »

©∑® qJA�«

¥±
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∫Ê√ o³Ý U2 Z²M²�½  
Æw�U�_« Èu²�L�« Í“«u¹ lÞU� Èu²�LÐ r�−�« lD� qO�²Ð r²¹ w�U�_« ŸUDI�«

ÆwI�_« Èu²�L�« Í“«u¹ lÞU� Èu²�LÐ lD� qO�²Ð r²¹ wI�_« ŸUDI�«
Æw³½U−�« Èu²�L�« Í“«u¹ lÞU� Èu²�LÐ lD� qO�²Ð r²¹ w³½U−�« ŸUDI�«

∫Full Section q�UJ�« ŸUDI�«

 ÆÁdš¬ v�≈ r�−�« ‰Ë√ s� lÞUI�« Èu²�L�« dL¹ YOŠ q�UJ�« ŸUDI�UÐ WIÐU��«  ôU×�« w� ŸUDI�« vL�¹
∫wK¹ U� WEŠö� V−¹ UM¼Ë

 s� WMOF� ¡«eł√ —UNþ≈ vKŽ ÂuIð ŸUDI�« WH�K� Ê_ p�–Ë ¨ŸUDI�« w� ©WFDI²�® WOH�� ◊uDš rÝdð ô
ÆŸUDI�« jI�L�UÐ ZðUM�« U¼bMŽ vL�¹Ë ¨U¼dOž ÊËœ lÞUI�« Èu²�L�« UNÐ d� r�−�«

ÆlDI�« Èu²�� jš sOÐ U�Ë tMOÐ U� —uB×L�« ¡e−�« W�«“≈ bFÐ …dýU³� dþUM�« Á«d¹ U� u¼ ŸUDI�« jI�L�U�

 e�«d� ◊uDš Â«b�²Ý« v�≈ V�UG�« w� bLF¹Ë ¨lÞUI�« Èu²�L�« —U�� b¹b×²� WMOF� …bŽU� s� „UM¼ fO�
Æn¹ËU−²�« qŁULð —ËU×�Ë »uI¦�«

¥≤
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 ∫Half Section ŸUDI�« nB½

 sOFÞU� sO¹u²�LÐ r�−�« lD� qO�ð r²¹ YOŠ  ̈s¹—u×� ‰uŠ WKŁUL²L�« ÂU�ł_« w� Î…œUŽ ŸuM�« «c¼ Âb�²�¹
ÆsODI�� w� lDI�« dNE¹ U¼bMŽË ¨©∏® qJA�« w� UL� s¹b�UF²�

 lD� Èu²��
w�U�√

 lD� Èu²��
w³½Uł

©∏® qJA�«

©π® qJA�«

 bFÐ r�−�« e�d� w� ÊUFÞUI²¹ w³½UłË w�U�√ sOFÞU� sO¹u²�LÐ tFD� qO�ð bFÐ r�−�« sO³¹ ©π® qJA�«Ë
ÆŸuDIL�« V¹dI�« ¡e−�« WŠ«“≈

¥≥
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ÆÎö�U� rÝdO� wI�_« jI�L�« U�√ ¨sL¹√ w³½Uł ŸUD� nB½Ë ¨d�¹√ w�U�√ ŸUD� nB½ ©±∞® qJA�« s³¹ 

√

Ó√

» ≠ Ó√ Ó√ ≠ √

»

©±∞® qJA�«

WEŠö�

 wHš U� dNE¹ ŸUDI�« nB½ Ê√ YOŠ WKŁUL²L�« ÂU�ł_« w� WFDI²L�« ◊uD��« rÝ— sŽ ¡UMG²Ýô« sJL¹
ÆjI�LK� dšü« nBM�« w�

¥¥
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∫UN²�ôœË lDI�« ◊uDš

 ? ÎUIÐUÝ XLKFð UL� ? rÝd¹ YOŠ ¨lÞUI�« Èu²�L�« —U�� b¹b×²� j�U�L�« bŠ« vKŽ lDI�« ◊uDš rÝdð
 q� V½U−Ð V²J¹Ë ¨ŸuDIL�« jI�L�« v�≈ Ê«dOA¹ sOLNÝ tO�dÞ bMŽ rÝd¹ ©T1.5 ≠ T® pOLÝ wzd� j�Ð

Æ©±±® qJA�« w� UL� ¨a�≈ ì ¨ » – » ¨ √ – √ q¦� ŸUDI�« rÝ≈ vKŽ ‰b¹ e�— rNÝ

lDI�« ◊uDš ∫©±±® qJA�«

∫©dOAN²�«® qOKE²�« ◊uDš

 ◊uDš vL�ð WOzUA½≈ ◊uD�Ð WKKE� U¼—UNþ≈ w¼ lÞUI�« Èu²�L�« UNÐ dL¹ w²�« ÕuD��« eOOL²� WF³²L�« …bŽUI�«
∫wK¹ ULÐ eOL²¹Ë ¨©±≤® qJA�« w� UL� UNM� Î«bŠ«Ë ÎUŽu½ bL²F½ ·uÝË Ÿ«u½√ …bŽ w¼Ë ¨qOKE²�«

Æ©2H® rKIÐ rÝdð WLOI²�� WKB²� WFO�— ◊uDš  ±
 ÌbŠ vKŽ —U�O�« Ë√ 5LO�« vKŽ ©o¥μ® W¹Ë«“ vKŽ WKzU� ◊uDš  ≤

Æ¡«uÝ
 V�Š  rK�  ©¥≠≤®  5Ð  ÕË«d??²??ðË  ¨WLE²M�  UNMOÐ   U�U�*«  ≥

Æ ŸuDI*« `D��« WŠU��
ÆŸuDI*« `D��« q¦9 w²�« WIDM*« œËbŠ sŽ hIMð ôË b¹eð ô  ¥

qOKE²�« ◊uDš ∫©±≤® qJA�«

 ∫ qOKE²�« bMŽ wK¹ U� …UŽ«d� V−¹Ë «c¼
 rÝd�«  w� UL� 5ð—ËU−²� 5²FDI� f�UF²� qOKEð Â«b�²Ý«Ë ¨…bŠ«u�«  WFDIK� bŠ«Ë ÌÁU&UÐ  qOKE²�«  ±

ÆwFOL−²�«
Æ©o¥μ W¹Ë«eÐ WKzU� ŸuDI*« `D��« œËbŠ ÊuJð U�bMŽ® W�Uš  ôUŠ w� o∂∞ Ë√ o≥∞ v�≈ o¥μ W¹Ë«e�« dOOGð  ≤

 ULMOÐ¨WŠuK�« rN� vKŽ ÎU³KÝ p�– dŁ√ «–≈ ô≈ ¨qOKE²�« ◊uDš X% ©WFDI²�® WOH�� ◊uDš rÝdð ô  ≥
Æe�d*« jš rÝ— sJ1

Æt×D�� Ì“«u� qJAÐ tFD� - «–≈ ©W¹uI²�« lK{® VBF�« qKE¹ô  ¥
ÆUNÐ W�Uš qOKEð ◊uDš …œU� qJ�  μ

¥μ
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©±® ‰U¦�

©≤® ‰U¦�

¥∂
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©≥® ‰U¦�

¥∑
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©¥® ‰U¦�

ÎUO³½Uł ÎUŽUD�ÎUO�U�√ ÎUŽUD�

ÎUOI�√ ÎUDI��

¥∏
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©μ® ‰U¦�

ÎUO³½Uł ÎUŽUD�ÎUO�U�√ ÎUŽUD�

ÎUOI�√ ÎUŽUD�

¥π
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©∂® ‰U¦�

ÎUO³½Uł ÎUŽUD�ÎUO�U�√ ÎUŽUD�

ÎUOI�√ ÎUŽUD�

μ∞
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©∑® ‰U¦�

d�¹√ w�U�√ ŸUD� nB½

ÎUOI�√ ÎUDI��

sL¹√ w³½Uł ŸUD� nB½

 lD� «–≈ VBF�« Ê√ kŠô
qKE¹ ô t½S� t×DÝ …«“«uLÐ

VBŽ

VBŽ

’
”

μ±
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∫wðü« ÕU²HL�« w� UL� »uKDL�« rÝ—« ∫s¹—ULð
ŸUD� nB½ rÝ—                         q�U� ŸUD� rÝ—        jI�� rÝ—     

©±® s¹d9

 
©≤® s¹d9

μ≤
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©≥® s¹d9

©¥® s¹d9

μ≥
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©μ® s¹d9

©∂® s¹d9

μ¥
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©∑® s¹d9

©∏® s¹d9

μμ
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©π® s¹d9

©±∞® s¹d9
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©±±® s¹d9

©±≤® s¹d9

μ∑
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©±≥® s¹d9

©±¥® s¹d9

μ∏
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©±μ® s¹d9

©±∂® s¹d9
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∂∞

≥≥…b?????Šu�«œU�uðË_UÐ  rÝd� «

…bŠu�« ·«b¼√
Æ…œbF²� ‚dDÐË l¹dÝË oO�œ qJAÐ  U�uÝd�« “U$« w� t�«b�²Ý«Ë œU�uðË_« Z�U½dÐ qOGAð s� sJL²�«  

Æ»uÝU(UÐ rÝd�«Ë  «Ëœ_UÐ ÍËbO�« rÝd�« 5Ð ‚dH�« f*  

ÆrÝd�UÐ W�öŽ UN� Èdš√ Z�«dÐ Â«b�²Ý«Ë qOGAð s� sJL²K� V�UD�«  «—b� WOLMð  

ÆœUFÐ_« WOŁöŁ ‰UJý_« rÝ— s� sJL²�«  
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∂±

œU�uðË_« qOGAð ∫‰Ë_« ”—b�«
 ◊uDš rÝd� ¢j��« rÝ—¢ d�_« oO³D²� dýRL�« Â«b�²Ý« ¨œU�uðË√ qOGAð WOHO� ”—b�« «c¼ w� rKF²MÝ

ÆœU�uðË√ s� ÃËd��«Ë tLÝdÐ UML� U� kHŠË ¨qOD²�L�« rÝ—Ë ¨WMOF�

 WŽuL−L�« v�≈ rŁ ¢Programs¢Z�«d³�« v�≈ qI²½≈ rŁ ¨“ËbM¹Ë w� ¢Start ¢√bÐ≈ —e�« vKŽ dIM�UÐ œU�uðË√ qGý
 vKŽ ≤∞±≥ œU�uðË√ W½uI¹√ ‚u� ÎUłËœe� Î«dI½ dI½√ Ë√ Æ¢AutoCAD 2013¢ vKŽ dI½«Ë ¢AutoCAD 2013¢

 ÆV²JL�« `DÝ

  vKŽ jGC�UÐ ÎUO�UŠ UNIKž√ ÆAutoCAD 2013 —«u×�« lÐd�Ø …c�UM�« p� dNE²Ý sO²IÐU��« sO²�U×�« w�
ÆœU�uðË√ ©Z�U½dÐ® WýUý Ëb³ð UN²E×�Ë ÆvMLO�«Ë W¹uKF�« UN²¹Ë«“ w� œułuL�«

WOÝUOI�« WLzUI�« wÝUOI�«  «Ëœ_« j¹dý hzUB��«  «Ëœ√ j¹dý

q¹bF²�«  «Ëœ√ j¹dý

W�U×�« j¹dý

rÝd�«  «Ëœ√ j¹dý

rÝd�« dýR� rÝd�« …c�U½

WM¹UFL�«  U³¹u³ð

d�«Ë_« …c�U½

œU�uðË√ Z�U½d³� W�UF�« WOJOÝöJ�« WOIO³D²�« WNł«u�« ∫©±® qJA�«
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∂≥

∫WO�U²�« W�UN�«  U½uJL�« s� Î«œbŽ Íu×ð ©rÝd�« WýUý® œU�uðË√ Z�U½d³� WOIO³D²�« WNł«u�« Ê√ WEŠö� UMMJL¹
ÆUL¼dOžË Edit d¹d% WLzU�Ë File nK� WLzUI� ¨WOÝUOI�« “ËbM¹Ë ©Menus® rz«u�   ±

 ÆWOÝUOI�« ©Toolbar®  «Ëœ_« j¹dý   ≤
 ÆModify Toolbar q¹bF²�«  «Ëœ√ j¹dýË Draw Toolbar rÝd�«  «Ëœ√ j¹dA� ¨WHK²��  «Ëœ√ WÞdý√   ≥

 W½uI¹√ œułË kŠô ÆUNKš«œ rÝd�« r²¹ ©w²�« WŠU�*«® WýUý w¼Ë ¨©Drawing Window® rÝd�« …c�U½   ¥
Æ©UCS Icon®  UOŁ«bŠù« ÂUE½

 V¹u³²�« ÊuJ¹ Æw�U(« rÝdK� WHK²��  UM¹UF� v�≈ ‰u�u�« s� pMJ9 w²�« WM¹UF*« ©Tabs®  U³¹u³ð  μ
ÆDefault w{«d²�ù« V¹u³²�« u¼ ©Model® ¢Ã–u/¢

Æd�«Ë_« WÐU²J� dDÝ_« s� œËb×� œbŽ s� W½uJ� …dOG� …c�U½ w¼Ë ©Command window® d�«Ë_« …c�U½  ∂
ÆÎö¦� rÝd�« dýR� l�u�  UOŁ«bŠ≈ V�«dð Ê√ pMJ1 YOŠ ©Status bar® W�U(« j¹dý   ∑

 œU�uðË√ w� d�_« cOHMð

 WOÝbM¼ WOKLŽ W¹√  cOHM²�  œU�uðË√ d�«Ë√ v�≈ ÃU²×ð p½S� ¨rÝd�« WýUý v�≈ qšbðË œU�uðË√ qGAð U�bMŽ
 rÝ—¢ d�_« Â«b�²Ý« pOKŽ ¨jš rÝdÐ X³ž— «–≈ ¨‰U¦L� ÆW�uÝdL�« d�UMF�« vKŽ q¹bFð Ë√ Ìu×�Ë rÝ— s�
 œU�uðË√ WýUý vKŽ W�uÝd� d�UMŽ u×� X³ž— «–≈ tÐUA� ÌqJAÐË ÆW¹UNM�«Ë W¹«b³�« w²DI½ b¹b×ð rŁ  Line¢jš

 ÆU¼u×L²Ý w²�« d�UMF�« —UO²š« rŁ  Erase ¢ u×� ¢d�_« v�≈ qšbð Ê√ pOKF�

 œU�uðË√ w� d�«Ë_« ‰Ušœ≈

œU�uðË√ w� d�«Ë_« ‰Ušœù W�Oz— ‚dÞ ÀöŁ błuð
 dNE¹ YOŠ ¨`OðUH*« WŠu� Â«b�²ÝUÐ d�_« WÐU²�   ±

Æd�«Ë_« …c�U½ w� d�_« rÝ«
ÆWOÝUOI�« WLzUI�« s� d�_« ¡UI²½«   ≤
Æ «Ëœ_« j¹dý s� d�_« ¡UI²½«   ≥

‰Ušœ≈ WOHO�

 ∫w�U²�« u×M�« vKŽ d�_« p� V²JMÝ ¨d�«Ë_« …c�U½ w� d�_« WÐU²� pM� VKÞ «–≈
 ¨‰Ušœù« ÕU²H� vKŽ jG{« rŁ QSAVE  d�«Ë_« …c�U½ w� V²�« nKL�« kH×� Í√® QSAVE  ∫V²�√

 ©  e�d�UÐ Îö³I²�� UN� e�dMÝ …dOš_« Ác¼Ë
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∂¥

 ∫w�U²�« u×M�« vKŽ d�_« p� V²JMÝ WO�Ozd�« WLzUI�« s� d�_« ¡UI²½« pM� UM³KÞ «–≈

Æ©W�b�ML�« WLzUI�« s� Save ¢kHŠ¢ d²š« rŁ WO�Ozd�« WLzUI�« s� File ¢nKL�«¢ d²š« Í√®  File>Save d²š«
 ∫w�U²�« u×M�« vKŽ d�_« p� V²JMÝ  «Ëœ_« j¹dý s� d�_« ¡UI²½« pM� UM³KÞ «–≈

ÆSave ¢kHŠ¢ W½uI¹√ d²š«

∫q�UA*« s� ÃËd)«

  «Ëœ_« W�dF� ÊS� p�c�Ë ¨ÎULz«œ ¡UDš√ »UJð—« v�≈ œU�uðË√ w� rÝdK� t²Ý—UL� bMŽ Âb�²�L�« ÷dF²¹
∫W�uN�Ð UNMŽ lł«d²�« vKŽ ÁbŽU�ð WO�U²�«

  ¨`OðUH*« WŠu� w� ©—U�O�« v�≈ ÎULNÝ Íu×¹Ë ‰Ušœù« ÕU²H� vKŽ√ błu¹® Backspace lł«d²�« ÕU²H�  ±
 ÆœU�uðË√ d�«Ë√ …c�U½ w� WOÐU²J�« ¡UDš_« sŽ lł«d²�« vKŽ ÕU²H*« Ác¼ ‰ULF²Ý« bŽU�¹ ∫©≤® qJý

 ÕU²H� vKŽ jGCð Ê√ q³� QD��« «c¼ v�≈ XN³²½« p½√Ë ¨qsave s� ÎôbÐ qsava∫X³²� p½√ Îö¦� ÷d²HM�  
ÆW×O×� WLKJ�« `³B²� e WÐU²�Ë WLKJ�« W¹UN½ w� a WÐU²� sŽ lł«d²�« pMJL¹ ¨ÌczbMŽ ¨‰Ušœù«

`OðUHL�« WŠu� w� lł«d²�« ÕU²H� ∫©≤® qJA�«

 »ËdN�« ÕU²H� jG{≈ ∫`OðUH*« WŠu� w� ©vKŽ_« w�Ë —U�O�« vKŽ ÕU²H� vB�√® Esc »ËdN�« ÕU²H�  ≤
ÆWŽd�Ð —«u(«  UFÐd� Ë√ d�«Ë_« bŠ√ ¡UN½≈ v�≈ ÃU²% U�bMŽ

 XM� «–S� ÆQD��« o¹dDÐ ¨©Circle® ¢…dz«œ¢ d�√ s� ÎôbÐ ¨©Line® ¢jš¢ d�√  d²š« p½√ ÷d²HM�  
ÆEsc »ËdN�« ÕU²H� jG{« ¨WŽd�Ð d�_« «c¼ ¡UN½≈ w� ÎU³ž«—

 sŽ lł«d²�UÐ Vždð XM�Ë ¨QD)« o¹dDÐ .b� szU� q¹bFð Ë√ b¹bł szU� rÝdÐ XL� «–≈ ∫Undo lł«d²�«  ≥
 XKF� ULK� Æd�«Ë_« …c�U½ w� u V²�« Ë√ ¨wÝUOI�«  «Ëœ_« j¹dý s�  ¢lł«dð¢ —“ vKŽ dI½« ¨p�–

Æp�cÐ Vždð XM� «–≈ ¨¡wý q� sŽ lł«d²�« pMJ1 ¨tÐ XL� qLŽ dš¬ sŽ œU�uðË√ lł«d²¹ p�–
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∂μ

 j¹dý s�  ¢…œUŽ≈¢ —“ Â«b�²Ý« pMJ1 ¨QD)« o¹dDÐ undo ¢lł«dð¢ X�b�²Ý« «–≈ ∫Redo …œUŽù«  ¥
 ¢…œUŽ≈¢ Â«b�²Ý« sJ1 ô Æd�«Ë_« …c�U½ w� redo WÐU²� Ë√ ¨lł«d²�« p�– fJF� wÝUOI�«  «Ëœ_«

Æ…bŠ«Ë …d� s� d¦�√
 W�Kł w� t²LÝ— ¡wý q� sŽ lł«d²�«  pMJL¹ p�c�Ë ¨…b¹bŽ  «d�  U  lł«d²�«  d�√ Â«b�²Ý« lOD²�ð  

ÆU lł«d²�« d�_ p�«b�²Ý« bFÐ …dýU³�Ë …bŠ«Ë …d� t�«b�²Ý« pMJLO� Redo …œUŽù« d�√ U�√ ÆœU�uðË√

Mouse ©…—QH�«® dýR*UÐ ◊uD)« iFÐ rÝ—

 oKG½Ë rÝd�«  kH×½ rŁ  rÝd�«  WýUý vKŽ ÊU� ULHO� dýRL�«  p¹d×²Ð  ◊uD��«  iFÐ rÝdÐ Êü« ÂuIMÝ
 «cJ¼ LINE  ∫ d�«Ë_« …c�U½ w� V²J½ ÆœU�uðË√

Command: LINE  

 WDIM�«  œbŠ¢ ?Ð  œU�uðË√ VO−²�O� © ® o�«u� ‰Ušœù« ÕU²H� vKŽ ¢jš rÝ—¢ d�_« WÐU²� bOFÐ jGC½
 «cJ¼  ¢∫v�Ë_«

Specify first point:   

 ÎUF³ðË ÆtLÝd²Ý Íc�« j�K� W¹«b³�« WDI½ p�cÐ œb×²� rÝd�« WýUý w� t³ždð ÌÊUJ� Í√ vKŽ dýRL�UÐ dI½√
 «cJ¼ ¢∫›sŽ lł«dð¤ Ë√ WO½U¦�« WDIM�« œbŠ¢ ?Ð œU�uðË√ VO−²�¹ p�c�

Specify next point or [Undo]: 

 w²DI½ sOÐ ÎULOI²�� ÎUDš XLÝ— p½√ b−ð „UM¼ Î«œb−� dI½«Ë WýUA�« vKŽ dš¬ ÌÊUJ� v�≈ rÝd�« dýR� „dŠ
 ô≈ pOKŽ UL� œU�uðË√ d�√ ¡UN½SÐ VždðË jI� WOD��« WFDI�« Ác¼ s� ÎU½uJ� pLÝ— ÊU� «–≈ ÆWO½U¦�«Ë v�Ë_« dIM�«

 ÆÈdš√ …d� ‰Ušœù« ÕU²H� vKŽ jGC�«

  d�_« ¡UN½ù Èdš√ ‚dÞ
 Esc `OðUHL�« WŠu� w� »ËdN�« ÕU²H� vKŽ jGC�UÐ

 Space bar ⁄«dH�« œuLŽ dIMÐ  
 dýRLK� 5LO�« —e�« vKŽ dIM�UÐ Ë√ ÆdýRLK� 5LO�« —e�« vKŽ dIM�UÐ  

Æ©≥® qJý ¨Enter UNM� —U²�ð W�b�M� WLzU� dNE²�
 dNEð W�b�M� WLzU� ∫©≥® qJý

 dýRLK� sOLO�« —e�« dI½ s�

 p�H½ b−ð Èdš√ …d� ‰Ušœù« ÕU²H� vKŽ jGC�« »dł ¢jš rÝ—¢ œU�uðË√ d�_ pzUN½≈ bOFÐË …dýU³� ¨Êô«
 …dOš_« WDIM�UÐ œU�uðË√ pDÐd¹ ‰Ušœù« ÕU²H� vKŽ b¹bł s� jGC�« Ê√ UL� Æjš rÝ— d�_« w� Í√ ¨oÐU��« d�_« w�
 ÆUNð«– …dOš_« WDIM�« s� ÎU�öD½≈ X�d×ð ULM¹√ ÎU½d� ÎUDš tF� V×�¹ dýRL�« Ê√ UN²E×� b−²ÝË ¨UNM� XON²½≈ w²�«
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∂∂

 Wþu×K�

 u²K� tM� XON²½«Ë t²�b�²Ý« Íc�« ÍœU�uðË_« d�_« s� ÃËd��« bOFÐ Èdš√ …d� ‰Ušœù« ÕU²H� vKŽ jGC�«
ÆœU�uðË√ d�«Ë√ qJ� Èdš√ …d� t�H½ d�_« v�≈ œU�uðË√ „bOF¹

 ÆdýRLK� sOLO�« —e�« vKŽ dIM�UÐ Ë√  Space bar ⁄«dH�« œuLŽ dIMÐ t�H½ d�_« v�≈ ÎUC¹√ Ÿułd�« pMJL¹
 ÆÈdš√ …d� ÎUIÐUÝ ÁU½d�– U� —«dJ²Ð UNM� XON²½« w²�« WDIM�« l� jÐd�« pMJL¹ UL�

j)« rÝ—
 »ËdN�«  ÕU²H�  jGC½  d¦�√  Ë√  sO²ODš  sO²FD�  s�  ÊuJ�  jš  rÝd�
 Line ¢jš rÝ—¢ d�_« q�K�ð l³²½ rŁ tzUN½≈ Ë√ oÐU��« d�_« s� ÃËd�K�

 ∫WO�U²�« Àö¦�« ‚dD�« ÈbŠSÐ tOKŽ qB×½ Íc�«Ë
¢j)« rÝ—¢ —e�« rÝd�«  «Ëœ√ j¹dý s� dI½√  rÝd�«  «Ëœ√ j¹dý ∫©¥® qJý

 Draw>Line WOÝUOI�« WLzUI�« s� d²š« Ë√  

 Draw WOÝUOI�« WLzUI�« ∫©μ® qJý
Line d�_« W�b�ML�« UN²LzU� sL{Ë

 rÝ—¢ d�_« cOHMð  v�≈  pK�uð UNFOLł w²�«Ë L  dB²�� ÌqJAÐ Ë√   Line d�«Ë_« …c�U½  w� V²�√ Ë√
«cJ¼ ∫¢j��«

Command: LINE    

LINE Specify first point:   rÝd�« WýUý vKŽ v�Ë_« WDIM�« b¹b×²� dýRL�UÐ dI½√  
Specify next point or [Undo]:   ›lł«dð¤ rÝd�« WýUý vKŽ WO�U²�« WDIM�« b¹b×²� dýRL�UÐ dI½√ 
Specify next point or [Undo]:  ›lł«dð¤ rÝd�« WýUý vKŽ WO�U²�« WDIM�« b¹b×²� dýRL�UÐ dI½√
..…………………      a�«ÆÆÆÆ WFÐ«d�« WDIM�« b¹b×²� dýRL�UÐ dI½√ ¨‰«uML�« fH½ vKŽ  

…………………..

Specify next point or [Close/Undo]: C   ›lł«dðØ‚öž≈¤ WDI½ ‰Ë√ l� WDI½ dš¬ jÐd�   
  ÆZðUM�« qJA�« oKž ©Close WLKJK� Î«—UB²š«® C ·d×�« wMF¹ YOŠ
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∂∑

 cOHMð sŽ lł«d²�« ÊS� TÞUš u¼ WODš WFDI� pLÝ— Ê√ ¢j��« rÝ—¢ d�_ „cOHMð ‚UOÝ w�  błË «–≈Ë
 rÝ—¢ d�_« cOHMð ‚UOÝ w� X½√Ë ¨p�c� ÆUndo lł«d²�« d�√ Â«b�²Ý« VKD²¹ WOD��« WFDI�« pKð rÝ— d�√

 ÆtM� ÃËd��« ÊËbÐË »uKDL�« d�_« qL�√ rŁ U dB²�� ÌqJAÐ Ë√ Undo V²�« ¢jš
 p�– ÊS� ÁcOHMð sŽ lł«d²�« b¹dðË ÎUOK� TÞUš pLÝ— Ê√ d�_« pzUN½≈ ‰UŠ  błË «–≈ ¨Èdš√ WNł s�

 ÆÎöBHM� Undo lł«d²�« d�√ Â«b�²Ý« VKD²¹

∫Wþu×K�

 ÍœR¹ –≈ ÆqBHM� d�Q� U 5ÐË  Line d�_« ‚UOÝ sL{ wŽd� —UO�� U lł«d²�« d�√ Â«b�²Ý« w� ‚d� błu¹
 WK�KÝ rÝ— s� bFÐ wN²Mð r� p½√ U*UÞ ¨W�uÝd*« ◊uD)« WK�KÝ w� WFD� dš¬ sŽ lł«d²�« v�≈ u wŽdH�« —UO)«
 lł«d²�« v�≈ ÍœRO� ©Command: u ® Í√ line d�√ s� ¡UN²½ô« bFÐ œU�uðË√ d�«Ë√ …c�U½ w� u WÐU²� U�√ ¨◊uD)«

 Ætð«– © line® dOš_« d�_« w� UN²LÝ— w²�« ◊uD)« q�U� sŽ

∫tzUI²½« ‚dÞË szU� ©Erase® ·cŠ
 ÆrÝd�« WýUý vKŽ s� UNCFÐ u×Lð Ë√ ·c×ð Ê√ lOD²�ð œU�uðË√ w�  UMzUJ�«Ë d�UMF�« iF³� pLÝ— bFÐ
 …c�U½ w� V²�« p�cÐ ÂUOIK� Æ÷dG�« «cN� ©Erase®¢·cŠ¢ d�√ Â«b�²Ý« pMJL¹ ¨w�uÝ— szU� s� hK�²K�Ë

 Æ©∂® qJý ¨q¹bF²�«  «Ëœ√ j¹dý s�  ¢·cŠ¢ —“ d²š« Ë√ ¨©dB²�� ÌqJAÐ e ® Ë√  Erase  d�«Ë_«

Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý ∫©∂® qJý

 WOÝUOI�« WLzUI�« s� ·c×�« d�√ vKŽ ‰uB×�« sJL¹ UL�
Æ©∑® qJý ¨ Modify>Erase

 d�_« UNO�Ë Modify WOÝUOI�« WLzUI�« ∫©∑® qJý
 Erase ·cŠ

 d²š«¢  tłu�  —uNþ  bMŽË   WIÐU��«   ôU×�«  lOLł  w??�Ë
 dýRL�«  —eÐ  dI½«  ¨d??�«Ë_«  …c�U½  w�  ©Select object®  ¢ÎUMzU�
 ÕU²H� U¼bFÐ jG{« ¨ÎUFDI²� `³BO� szUJ�« p�– vKŽ d�¹_«
 WI¹dD�« Ác¼ vL�ðË ÆsL¹_« dýRL�« —“ jG{« Ë√  ‰Ušœù«

  ÆœdHL�« ¡UI²½ôUÐ bŠ«Ë szU� ¡UI²½ô
  UMzUJ�«  Ë√  szUJ�«  dI½  w¼ WOKLF�«Ë …dýU³L�«  ‚dD�«  s�
  ·c×�«  ÕU²H� vKŽ jGC�«  rŁ  rÝd�«  s� UN�c×Ð Vžd½ w²�«

   Æ`OðUHL�« WŠu� s� Delete
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∂∏

∫w�U²�« q�K�²�« l³²¹ œU�uðË√ w� bOŠËË bŠ«Ë szU� Erase ·cŠ ÊS�  ôU×�« lOLł w�Ë
Command: Erase 

 —UO²šô lÐdL�« «c¼ Âb�²Ý« ¨pick box —UO²š« lÐd� v�≈ dýRL�« ‰u×²¹ ‰Ušœù« ÕU²H� vKŽ pDG{ ‰UŠ
  d�_« qLJ½ Æt�c×Ð Vždð Íc�« dBMF�«

Select objects: 

WO�U²�« W�UÝd�« dNE²� t�c×Ð Vždð Íc�« szUJ�« dýRLK� d�¹_« —e�UÐ dI½«
Select objects:1 found

dýRLK� sL¹_« —e�« vKŽ dIM�« Ë√ ‰Ušœù« ÕU²H� vKŽ jGC�UÐ d�_« qLJ½ ¨t�cŠ »uKDL�« szUJ�« ¡UI²½« rð Í√

Select objects: 

 U�bMŽ W�Uš ¨WOKLŽ dOž WI¹dÞ Î«bŠ«Ë Î«bŠ«Ë  UMzUJ�« ¡UI²½« w� WI¹dD�« Ác¼ d³²FðË Æ·c×�« d�√ vN²½« UM¼
 ÎU�dÞ œU�uðË√ d�u¹ p�c�Ë Æ…œb×� WIDM� w� Ë√ …bŠ«Ë WNł vKŽ bł«u²ðË  UMzUJ�« s� …dO³� WOL� ·c×Ð Vždð

 ∫wK¹ UL�  UMzUJ�« ¡UI²½ô Èdš√
 œU�uðË√  ÂuIO�  ¨  rŁ  ¨¢ÎUMzU�  d²š«¢ tłuL�«  —uNþ bMŽ All  V²�«  WýUA�«  vKŽ  UMzUJ�«  q� ·c×�

«cJ¼ ÆWHOE½ WýUA�« `³BðË ÎUFOLł UN�c×Ð
Command: Erase 

Select objects: all 

5 found 

Select objects: 

 ÂbI²�

 rÝd�« s� …bŠ«Ë WNł vKŽ  UMzU� Ë√ d�UMŽ WŽuL−� ¡UI²½ô
 ¨¢ÎUMzU� d²š«¢ tłuL�« —uNþ bMF� ÆÎUC¹√ dýRL�UÐ p�– qLŽ sJL¹
  UMzUJ�« sOL¹ vKŽ ⁄—U� ÊUJ� w� …bŠ«Ë …d� d�¹_« dýRL�« —“ dI½«
 U¼bMŽ ¨—U�O�« v�≈ sOLO�« s� dýRL�« „dŠ rŁ ¨UNzUI²½UÐ Vždð w²�«
 «c¼ qF−ð Ê√ ‰ËUŠ ÆCrossing jIM� j�Ð qOD²�� Ë√ —UÞ≈ dNE¹
 Vždð w²�«  UMzUJ�« Íu²×¹ v²Š Ë√ lDI¹ Ë√ f�ö¹ jIML�« —UÞù«
 ÕU²H� U¼bFÐ jG{«Ë a�«ÆÆÆÆÆÆUN��½ Ë√ UN�c×� UNF� q�UF²�UÐ

Æ©∏® qJý ¨sL¹_« dýRL�« —“ jG{« Ë√  ‰Ušœù«—U�OK� sOLO�« s� …c�UMÐ  UMzUJ�« ¡UI²½« ∫©∏® qJý
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∂π

 d²š«¢ tłuL�« —uNþ bMF� ∫Èdš√ WI¹dÞ Â«b�²Ý« sJL¹ UL�
 —U�¹ vKŽ ⁄—U� ÊUJ� w� …bŠ«Ë …d� d�¹_« dýRL�« —“ dI½« ¨¢ÎUMzU�
 —U�O�«  s� dýRL�«  „dŠ rŁ ¨UNF� q�UF²�UÐ  Vždð w²�«   UMzUJ�«
 ÆWindow qB²� j�Ð qOD²�� Ë√ —UÞ≈ dNE¹ YO×Ð ¨sOLO�« v�≈
 Vždð w²�«  UMzUJ�« Íu²×¹ qB²L�« —UÞù« «c¼ qF−ð Ê√ ‰ËUŠ
 dýRL�«  —“  jG{«  Ë√   ‰U??šœù«  ÕU²H�  U¼bFÐ  jG{«Ë UNzUI²½UÐ

Æ©π® qJý sL¹_«sOLOK� —U�O�« s� …c�UMÐ  UMzUJ�« ¡UI²½« ∫©π®qJý

 ¢ÎUMzU� d²š«¢ Y×LK� WÐU−²ÝU� W WÐU²JÐ Crossing selection lDI²� Ë√ jIM� —UÞ« vKŽ ‰uB×�« sJL¹
 W WÐU²JÐ Window selection qB²� —UÞ« vKŽ ‰uB×�« sJL¹ ULMOÐ ÆÈd�O�U� ÎôË√ vMLO�« sO²¹Ë«e�« œb×½ rŁ
 WFÞUI²� U�≈ ÊuJð …—U²�L�« d�UMF�«Ë ÆvMLO�U� ÎôË√ Èd�O�« sO²¹Ë«e�« œb×½ rŁ ¢ÎUMzU� d²š«¢ Y×LK� WÐU−²ÝU�

  Æq�UJ�UÐ qB²L�« —UÞù« qš«œ Ë√ tKš«œ Ë√ jIML�« —UÞù« l�

rÝd�« kHŠ

 œU�uðË√ s� w{«d²�ù« rÝù« X×ð wz«b²Ð« nK� sL{ ÊuJð v�Ë_« …dLK� œU�uðË√ Z�U½dÐ p�ušœ ‰UŠ
 r� rÝd�« Ê_Ë ÆFile>Save Í√ ¨wÝUOI�«  «Ëœ_« j¹dý s� SAVE d²š≈ t²LÝ— U� kH×� ÆDrawing1.dwg

 Æ©±∞® qJý ¨©Save Drawing As® ¢rÝUÐ kHŠ¢ —«u×�« lÐd� ÷dFÐ œU�uðË√ ÂuIOÝ bFÐ kH×¹
 X³ž— «–≈  ÆtO�  pLÝ— kH×Ð Vždð Íc�«  bK−L�«Ë ’dI�«  œbŠ „UM¼
 ACAD2013 bK−L�« vKŽ ≤∞±≥ œU�uðË√ ”Ë—œ s� ‰Ë√ ”—b� tEH×Ð

∫WO�U²�« WGOB�UÐ tEH×½ UM½S� V²JL�« `DÝ sL{
Desktop:\ACAD2013\LESSON1. 

 j¹dý s�    —e�« jG{« rÝd�« kH(
ÆwÝUOI�«  «Ëœ_«

  «dOOG²�«Ë pLÝ— kH% Ê√ ÎULz«œ d�cð
Æq�√ Ë√ ozU�œ μ q� tOKŽ Wz—UD�«
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∑∞

Save Drawing As —«u×�« lÐd� ∫©±∞® qJý

œU�uðË√ ‚öž≈

 vKŽ jG{« Ë√ d�«Ë_« …c�U½ w� Quit Ë√ Exit s¹d�_« bŠ√ V²�√ Ë√ ¨File> Exit d²š≈ ¨œU�uðË√ W�Kł ¡UN½ù
ÆrÝd�« WýUA� vMLO�«Ë W¹uKF�« W¹Ë«e�« w� …œułuL�«  X…—Uýù«

∫tO³Mð

 rÝd�« «c¼ Ê√ błË «–S� ¨rÝd�« vKŽ  ö¹bFð W¹√ œułË ÂbŽ s� Z�U½d³�« oI×²¹ œU�uðË√ ‚öžSÐ ÂuI½ U�bMŽ
 ŸUO{ s� vA�ð ô Ê√ pOKŽ «cN�Ë ¨p�– sŽ t�Q�¹ t½S� UNEH×Ð bFÐ Âb�²�L�« rI¹ r�  ö¹bFð vKŽ Íu²×¹

ÆœU�uðË√ ‚öž≈ bMŽ p�uÝ—
 nKL�« kH×Ð ÂuI¹ w½U¦�« d�_U� Æd�«Ë_« …c�U½ w� Save d�_«Ë Qsave d�_« WÐU²� sOÐ W−O²M�« w� ‚d� błu¹
 w� Save —e�« vKŽ dIM�« Ë√ File>Save —UO²š« ULMOÐ ÆSave As Í√ q³� s� t²EHŠ b� XM� u� v²Š b¹bł rÝUÐ

 Æ…b¹b−�« tð«dOG²Ð nKL�« kH×� ÊU¹œRO� WOÝUOI�« WLzUI�«
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∑±

oO�b�« rÝd�« ∫w½U¦�« ”—b�«
 WOÝUÝ_« d�UMF�« rÝd� œU�uðË√ w� WHK²�L�«  UOŁ«bŠù« WLE½√ Â«b�²Ý« WOHO� w½U¦�« ”—b�« w� rKF²MÝ

 ÆÎUIO�œ ÎULÝ—  UFKCL�«Ë dz«Ëb�«Ë  öOD²�L�«Ë ◊uD��U�

b¹bł rÝ— ¡bÐ

Æw�U(« nK*« ‚öžù File> Close d²š≈   ±
 Æ©±±® qJý ¨AutoCAD 2013 …c�UM�« p� dNE²Ý ¨File>New d²š«   ≤

©±±® qJý

∫Wþu×K�

 Ë√  WFzUA�«  w¼Ë  W¹d²LOKO�   «bŠuÐ  rÝdð  bI�  ÆUN³ždð   «b??ŠË  W¹QÐ  œU�uðË√  w�  rÝd�«  r²¹  WIOI×�«  w�
 rÝdð X�œ U� ‚dH�UÐ dFAð s�Ë tÐUA²� ÌqJAÐ rÝd�«  «bŠË lOLł l� q�UF²²Ý sO²�U×�« w�Ë Æg½ù«  «bŠË
 W¹d²LOKOL�«  «bŠu�« U�≈ bŠ«u�« nKL�« w� Âb�²�ð Ê√ qCH¹ sJ� ÆbŠ«u�« rÝd�« nK� w�  «bŠu�« ÈbŠSÐ

 Æg½ù«  «bŠË U�≈Ë
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∑≤

rÝd�« œËbŠ j³{

 r−Š v�≈ rÝd�« œËbŠ j³{ s�×²�L�« sL� p�c�Ë ¨wIOI×�« UNÝUOILÐ …œUŽ œU�uðË√ w� ¡UOý_« rÝdð
 Ác¼ r−Š v�≈ rÝd�« œËbŠ j³{ UM�eK¹ t½S� ÷dF�UÐ A4 W�—Ë vKŽ rÝd�UÐ UM³ž— «–≈ ÆtLÝdÐ ÂuI½ Íc�« TOA�«
 ∫WÐuKDL�« rÝd�« œËbŠ ÎôË√ ·dF½ ¨p�c� Æ©±≤® qJý ¨ŸUHð—û� d²LOK� ≤±∞ Ë ‰uDK� d²LOK� ≤π∑ Í√ W�—u�«

 rÝd�« œËbŠ j³C� Limits WLKJ�« d�«Ë_« …c�U½ w� V²�√

∫tO³Mð

 Ê√ lOD²�ð ô p½√ rÝd�« œËbŠ wMFð ô
 ÆrÝd�« bMŽ U¼“ËU−²ð

    
  ÷dF�UÐ A4 rÝd�« W�—Ë œËbŠ∫©±≤® qJý

Command: Limits  

Reset Model space limits:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>: 

Æœd�« wðQ¹ UM¼Ë (0,0) UNðUOŁ«bŠ≈ w²�«Ë WOKH��«Ë Èd�O�« W¹Ë«e�« s� oKDM½ UM½_ sOI�«u� ‰Ušœù« ÕU²H� jGC½ ¨UM¼
Specify upper right corner <420.0000,297.0000>: 297,210  

 v�≈  <420.0000,297.0000>  dG�√Ë d³�√ wð—Uý≈ sOÐ  WMO³L�«  œU�uðË√ Z�U½d³�  WO{«d²�ù« WLOI�«  dOG½  UM½√  Í√
 Æ297,210  Y×L�« rIK½ ¨p�c� Æb¹b×²�UÐ A4 rÝd�« W�—Ë œUFÐ√ l� o�«u²ð w²�«Ë …b¹b−�« WLOI�«

 s� d²š≈ ¨p�c� ÆœU�uðË√ w� rÝd�« W�œ b¹b×²� W¹dAF�« q�«uH�« j³{ v�≈ ÃU²×½ b� ¨Èdš√ WNł s�
 —«uŠ lÐd� ÷dFÐ sO²�U×�« w� œU�uðË√ ÂuIO� ¨Units d�«Ë_« …c�U½ w� V²�« Ë√ Format>Units WOÝUOI�« WLzUI�«
  «bŠË r�� w� Decimal ¢ÍdAŽ¢ ¡UI²½« s� „UM¼ b�Qð Æ©±≥® qJý ¨Drawing Units ¢rÝd�«  «bŠË¢
 jG{«Ë Precision ¢W�b�«¢ v�≈ qI²½« rŁ ÆAngle ¢W¹Ë«“¢ r�� w� ¢W¹dAŽ  Uł—œ¢Ë ¨Length ¢‰uD�«¢

ÆOk o�«u� —“ jG{« rŁ ¢0¢ d²š«Ë ¢0.0000¢ —«uł v�≈ rN��« vKŽ
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∑≥

“rÝd�«  «bŠË” —«u×�« lÐd� ∫©±≥® qJý

 «–S�  ¨rÝd�«  W�œË o�«u²¹  rÝd�«  WýUý vKŽ dNE¹  U�  sJ�Ë œËb×�«  bFÐ√  v�≈  oO�œ  œU�uðË√  w�  tLÝdð  U�
  «bŠË ±∞ ”UOI�«  bMŽ t�uÞ Ê√ b−²Ý `O×� ± W�bÐ …bŠË π[∏¥π≤  wKFH�«  t�uÞ ÎULOI²�� ÎUDš XLÝ—

 Æ∞[∞± W�bÐ …bŠË π[∏μ Ë ∞[± W�bÐ …bŠË π[∏ ©j��«® tÝUO� ÊuJ¹Ë ¨‰ULJ�«Ë ÂUL²�UÐ

 WO�U×�« WM¹UFL�« œËbŠ j³C� ÆrÝd�« WýUý vKŽ ÎUO�Uð tLÝd²Ý U�  «bŠËË W�œ j³CÐ œU�uðË√ w� u²K� XL�
«cJ¼ ¨A  rŁ Z ∫V²�« ¨rÝd�« WýUý vKŽ szU� Í√ rÝd½ Ê√ q³� A4 W�—Ë w¼ w²�«Ë rÝd�« œËbŠ wDGð YO×Ð
Command: Z 

ZOOM

Specify corner of window, enter a scale factor (nX or nXP), or

[All/Center/Dynamic/Extents/Previous/Scale/Window] <real time>: A  
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∑¥

 UOŁ«bŠù« WLE½√ rN�

 «c¼ “ËU−²ðô p�c�Ë ÆWHK²�L�«  UOŁ«bŠù« rE½ rN� vKŽ ¨œU�uðË√ w� U¼d¹d×ðË  UMzUJ�« rÝ— n�u²¹
ÆÎU×O×� ÎULN� tLN� s� b�Q²�« q³� r�I�«

©Absolute Cartesian Coordinate System® oKD*« wð—UJ¹b�«  UOŁ«bŠù« ÂUE½

 r�d�« q¦L¹ Æ©X,Y®WK�U� ULNMOÐ qBH¹ ÂU�—_« s� ÃËeÐ oKDL�« wð—UJ¹b�«  UOŁ«bŠù« ÂUE½ w� WDIM�« ·dFð
 ¢’¢ w½U¦�« r�d�« q¦L¹Ë ÆWMOFL�« WDIM�«Ë  ÍœUB�«  UOŁ«bŠù« —u×� sOÐ WK�UH�« W�U�L�« X  Ë√ ¢”¢ ‰Ë_«
 wð—UJ¹b�« WH� ÂUEM�« «c¼ vKŽ oKD¹ p�c�Ë ÆUNð«– WDIM�«Ë wMO��«  UOŁ«bŠù« —u×� sOÐ WK�UH�« W�U�L�« Y Ë√

 ÆWOŠU�L�« ‰ULŽú� VÝUM� tMJ�Ë ¨w�uO�« qLF�« w� œU�uðË√ w� ÂUEM�« «c¼ Â«b�²Ý« qCH¹ ôË ÆoKDL�«

©±¥® qJý   ∫± ‰U¦�

 qO�²MÝ ÆB(30,40) ULMOÐ A(20,10) ULNðUOŁ«bŠ≈ Ê√ YOŠ ¨B Ë A sO²DIM�« sOÐ ©WOD��« WFDI�«® rOI²�L�« j��« rÝ—√
 Èd�O�« W¹Ë«e�« w� √b³ð WIKD�  UOŁ«bŠ≈ W�—u�« w� Ê√ qO�²½ ÆW�ËdF� œUFÐ√ UN� WDD��Ë WKOD²�� W�—Ë vKŽ rÝd½ UM½√
  Line d�_« V²�√ ÆLimits d�ú� ÎUI�Ë (297,210) WDIM�« w� vMLO�«Ë W¹uKF�« WDIM�« w� wN²MðË (0,0) WDIM�« w� WOKH��«Ë
Command: LINE 

Specify first point: 20,10 

Specify next point or [Undo]: 30,40  

Specify next point or [Undo]: 

©Relative Cartesian Coordinate System® w³�M�« wð—UJ¹b�«  UOŁ«bŠù« ÂUE½

 dš¬ sOÐ wMO��« bF³�« ©dx®q¦Lð  Æ©@dx,dy®…—U³FÐ w³�M�« wð—UJ¹b�«  UOŁ«bŠù« ÂUE½ w� WDIM�« ·dFð
 dš¬ sOÐ ÍœUB�« bF³�« (dy) q¦Lð UL� Æ©Delta x sO²DIM�« sOÐ wMO��« bF³�« Ë√® WO�U²�« WDIM�«Ë UN�Ušœ≈ rð WDI½
 WH� ÂUEM�« «c¼ vKŽ oKD¹ p�c�Ë Æ©Delta y sO²DIM�« sOÐ ÍœUB�« bF³�« Ë√® WO�U²�« WDIM�«Ë UN�Ušœ≈ rð WDI½

Æw³�M�« wð—UJ¹b�«

©±¥® qJý   ∫≤ ‰U¦�

 WDIM�« bF³ð ULMOÐ A(20,10)  UOŁ«bŠ≈ Ê√ YOŠ ¨C Ë A sO²DIM�« sOÐ ©WOD��« WFDI�«® rOI²�L�« j��« rÝ—√ 
Line d�_« V²�√ Æ¥∞ WOÝ√d�« W�U�L�«Ë ≥∞ WOI�_« W�U�L�UÐ A WDIM�« sŽ C
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∑μ

Command: LINE  

Specify first point: 20,10 

Specify next point or [Undo]: @30,40  

Specify next point or [Undo]: 

 Æv�Ë_« WDIM�« v�≈ W³�M�UÐ WO�U²�« WDIM�« bFÐ œb×¹ Íc�« @e�d�« UM�b�²Ý« UM½√ Í√

 UOŁ«bŠù« WLE½√∫©±¥® qJý

©Relative Polar Coordinate System® w³�M�« w³DI�«  UOŁ«bŠù« ÂUE½

 W�U�L�« distance  q¦L¹  Æ©@distance<angle® …—U³FÐ w³�M�« w³DI�«  UOŁ«bŠù« ÂUE½ w� WDIM�« ·dFð
 UN�Ušœ≈ rð WDI½ dš¬ sOÐ WK�U×�« W¹Ë«e�«  angle  q¦L¹Ë Æ…b¹b−�« WDIM�«Ë UN�Ušœ≈ rð WDI½ dš¬ sOÐ WK�UH�«

 Æw³�½ WH� ÂUEM�« «c¼ vKŽ oKD¹ p�c�Ë Æ” —u×� v�≈ W³�M�UÐ …b¹b−�« WDIM�«Ë

©±¥® qJý   ∫≥ ‰U¦�

 WDIM�« bF³ð ULMOÐ A(20,10)  UOŁ«bŠ≈ Ê√ YOŠ ¨D Ë A sO²DIM�« sOÐ ©WOD��« WFDI�«® rOI²�L�« j��« rÝ—√
Line d�_« V²�√ ÆWł—œ ≥∞ WO³DI�« W¹Ë«e�UÐË μ∞ WO³DI�« W�U�L�UÐ A WDIM�« sŽ D

Command: LINE 

Specify first point: 20,10 

Specify next point or [Undo]: @50<30

Specify next point or [Undo]: 

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



∑∂

 W�bÐ qOD²�� rÝ—

  UOŁ«bŠUÐË …œb×� ÁœUFÐ√ ÎöOD²�� rÝd½ nO� ÂuO�« rKF²MÝ ÆdýRL�UÐ qOD²�� rÝ— WOHO� ÎUIÐUÝ UMLKFð
 wF�u� œb×½ tLÝd�Ë ÆÎULz«œ  WOÝ√—Ë WOI�√  tŽö{√ ÊuJð YO×Ð œU�uðË√  w� qOD²�L�«  rÝd¹  ÆÎUHKÝ W�ËdF�

 Æ  qOD²�L�« rÝd� œU�uðË√ w� Âb�²�L�« e�d�« p�– v�≈ dOA¹ UL� ÎU�ULð sO²KÐUI²L�« tO²¹Ë«“

 ∫¥ ‰U¦�

Æ…bŠË μ∞ tŽUHð—«Ë ±∞∞ t�uÞ Íc�« qOD²�L�« rÝ—√
Command: Rectangle  (Rec )

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]: انقر أية نقطة على الشاشة 

Specify other corner point or [Dimensions]: @100,50 

 Æ@100,50 ÎôbÐ 100,50 Y;« w� UMLI� «–≈ …bŠË μ∞ Ë ±∞∞ oÐU��« qOD²�*« ‰«uÞ√ ÊuJð q¼  

∫μ ‰U¦�

 Æt�«uÞ√ W�ËdFL�« qOD²�L�« rÝd� Èdš√ WI¹dÞ
Command: Rec 

Specify first corner point or 

[Chamfer/Elevation/Fillet/Thickness/Width]:       WýUA�« vKŽ WDI½ W¹√ dI½«
Specify other corner point or [Dimensions]:  D

 Ætð«– qOD²�L�« Dimensions  ¢œUFÐ√¢ v�≈ qOD²�LK� WO½U¦�«  WDIM�«  l�u� b¹b×ð s� Y×L�« U½dOž ¨UM¼
 «cJ¼ Æ…bŠË Width μ∞ ŸUHð—ô«Ë …bŠË Length ±∞∞ ‰uD�« rOIK²Ð d�_« qLJ½ ÆD ·d×�« UM³²� p�c�Ë

Specify length for rectangles <500.0000>: 100 

Specify width for rectangles <40.0000>: 50 

Specify other corner point or [Dimensions]:

Æ»uKDL�« qOD²�L�«« Z²MO� WOKH��« Â√ W¹uKF�« sO²N−�« ÈbŠ≈ dýRL�UÐ dIM½

 ÆqOD²�*« rÝd� ÁöŽ√ 5ðœ—«u�« 5²I¹dD�UÐ …bŠË ≤∞ tFK{ t�uÞ Íc�« lÐd*« rÝ—√  
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∑∑

 UFKC*« rÝ—

 rÝdÐ œU�uðË√ ÂuI¹ ¨ÎUO{«d²�« ÆUN�U−Š√Ë UNŽö{√ œbŽ ·ö²š« vKŽ  UFKCL�« rÝ— s� œU�uðË√ UMMJL¹
 fLð Ë√ ©Inscribed in circle …dz«b�« qš«œ lKCL�«® lKCL�« ”Ëƒ— w� dLð WOL¼Ë …dz«œ v�≈ Î«œUM²Ý« lKCL�«
 rÝd� Èdš√ WI¹dÞ d�u²ð UL� Æ© Circumscribed about circle …dz«b�« Ã—Uš lKCL�«® qš«b�« s� tŽö{√
 Î«œUM²Ý« ÁöŽ√ œ—«u�« lÐdL�« rÝd� Èdš√ WI¹dÞ rKF²½ Ê√ dýU³� ‰U¦L�Ë ‰ËU×MÝ ÆtFK{ ‰uÞ v�≈ Î«œUM²Ý« lKCL�«

 ÆrE²M� wŽUÐ— lKC� t½√ v�≈

∫∂ ‰U¦�

 Æ…bŠË ≤∞ tFK{ ‰uÞ Íc�« lÐdL�« rÝ—«
 Pol  Ë√  Polygon  V²�√ Ë√ rÝd�«  «Ëœ√ j¹dý w� ¨©±μ® qJý ¨Polygon ¢lKC�¢ —e�« d²š«

Æ‰Ušœù« ÕU²H� jG{«Ë d�«Ë_« Y×� w�dB²�� qJAÐ

 UFKCL�«∫©±∂® qJý            lKCL�« rÝ— —“ tO�Ë rÝd�«  «Ëœ√ j¹dý ∫©±μ® qJý

Command: Polygon 

Enter number of sides ¢Ÿö{_« œbŽ qšœ√¢ ?Ð VO−²�¹ d�«Ë_« Y×� Ê√ b−ð sO²�U×�« w�Ë
Enter number of sides <3>: 4          ‰Ušœù« ÕU²H� jG{«Ë ¥ V²�« 
Specify center of polygon or [Edge]: e 

 ‰Ušœù« ÕU²H� jG{« rŁ Edge ¢lKC�« ‰uÞ¢ —UO²šô« cOHM²Ð Vždð p½√ wMFð  e·d×�« WÐU²�
Specify first endpoint of edge: 100,100           U¼œbŠ Ë√ U� WDI½ dI½√ 
Specify second endpoint of edge: @20,0   

Æ©±∂® qJý ¨100,100 v�Ë_« WDIMK� W³�½ lKC�« W�UŠ  UOŁ«bŠ≈ œb×½  @20,0 ?Ð UM¼

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



∑∏

∫∑ ‰U¦�

©±∂® ¨…bŠË ≥∞ tFK{ t�uÞ Íc�« fL�L�« rÝ—√
Command: Polygon 

Enter number of sides <4>: 5  

Specify center of polygon or [Edge]: e 

Specify first endpoint of edge: 100,100          U¼œbŠ Ë√ U� WDI½ dI½√
Specify second endpoint of edge: @30,0 

∫∏ ‰U¦�

  Æ…bŠË ±∞∞ U¼dD� nB½ ¨WOL¼Ë …dz«œ tÝËƒ— w� dLð Íc�« YK¦L�« rÝ—√
Command: Polygon 

Enter number of sides <4>: 3 

Specify center of polygon or [Edge]:      WýUA�« vKŽ WDI½ W¹√ dI½«
Enter an option [Inscribed in circle/Circumscribed about circle] <I>: I  

Specify radius of circle: @100<0 

∫π ‰U¦�

Æ…bŠË ±∞∞ U¼dD� nB½ ¨WOL¼Ë …dz«œ tŽö{√ fLð Íc�« YK¦L�« rÝ—√
Command: Polygon  

Enter number of sides <5>: 3 

Specify center of polygon or [Edge]:         WýUA�« vKŽ WDI½ W¹√ dI½«      
Enter an option [Inscribed in circle/Circumscribed about circle] <I>: C 

Specify radius of circle: @100<0 
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∑π

 œU�uðË√ w� dz«Ëb�« rÝ—

 uŽb½ ULMOÐ ©radius® dDI�« nBMÐ bF³�« p�– vL�¹Ë ÆU� WDI½ sŽ ÎU²ÐUŁ Î«bFÐ tÞUI½ bF³ð wÝbM¼ szU� …dz«b�«
∫w�U²�« ‰U¦L�UÐ UNKN²�½ ¨…dz«b�« rÝd� ‚dÞ …bŽ œU�uðË√ d�u¹Ë Æe�dL�UÐ W²ÐU¦�« WDIM�«

∫±∞ ‰U¦�

 Ác¼ rÝd� øW¹—UO²š« WLO� W¹√ U¼dD� nB½Ë rÝd�« WýUý vKŽ U� WDI½ U¼e�d� w²�« …dz«b�« dýRL�UÐ rÝ—√
 ∫WO�U²�«  «uD��« l³²MÝ  UH�«uL�« ÁcNÐ …dz«b�«

 rÝd�«  «Ëœ√ j¹dý w�   …dz«b�« —“ dI½« Ë√ d�«Ë_« Y×� w� ©Î«—UB²š« C V²�« Ë√®  Circle  V²�√
 Center,Radius —UO²šô« œb×½ „UM¼Ë ¨©±∑® qJý ¨Draw>Circle WOÝUOI�« WLzUI�« s� d²š« Ë√

rÝd�« WLzU� ∫©±∑® qJý

Command: Circle  (C )

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

 …bŽ œU�uðË√ pODF¹ ¨UM¼ ¤ Ë√ UNLÝd²Ý w²�« …dz«bK� Î«e�d� ÊuJ²Ý w²�« WDIM�« œb×ð Ê√ œU�uðË√ pM� VKD¹
ÆrÝd�« WýUý vKŽ WDI½ W¹√ dI½«    ÆÆÆÆ d�_« qLJ½ Æ›…dz«b�« Ác¼ rÝd�  «—UOš

 d³Jð  e�dL�« «c¼ ‰uŠ …dz«œ dNEð UL� ÆrÝd�« WýUý vKŽ ÎULÝ— …dz«b�« e�d� p� œb×O� œU�uðË√ VO−²�¹ UM¼
 …dz«b�« Radius dD� nB½ œb×ð Ê√ œU�uðË√ pM� VKD¹ ¨UM¼ ÆrÝd�« WýUý vKŽ dýRL�« W�d×� ÎUI�Ë dGBðË

Æd�_« qLJ½ Æ›…dz«bK� Diameter dDI�« u¼ dš¬ Î«—UOš œU�uðË√ pODF¹¤ Ë√ UNLÝd²Ý w²�«
Specify radius of circle or [Diameter]:      dš¬ ÌÊUJ� Í√ w� dI½«Ë WýUA�« vKŽ dýRL�« V×Ý« 
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∏∞

 ÂuIð XM� «–≈Ë ÆU¼e�d�  UOŁ«bŠ≈ ôË U¼dD� nB½ ô ·ËdF� dOž ¨…dz«œ XLÝ— p½√ V�UD�« Íe¹eŽ kŠöð
 U� sJ�Ë ¨…dz«b�« dD� nB½ ’uB�Ð  UŠd²I� W¹√ œU�uðË√ pOKŽ Õd²I¹ sK� ¨rÝd�« W�Kł w� …dz«œ ‰Ë√ rÝdÐ
 pMJL¹Ë Æcircle d�√ X�b�²Ý« ULK� W�uÝd� …dz«œ dš¬ dD� nB½ Õ«d²�UÐ œU�uðË√ ÂuI¹ v²Š …dz«œ ‰Ë√ rÝdð Ê≈
 Æ„bŠu� p�– »dł ÆW�uÝd� …dz«œ dš¬ dD� nB½ UN� ÊuJ¹ YOŠ …b¹b−�« …dz«b�« rÝ— ‰Ušœù« ÕU²H� jGCÐ

ÁöŽ√ œ—«u�« ¨©±∑® qJý dE½√ ¨…dz«b�« rÝd� WMJL*«  «—UO²šô«  
 Æ©radius® U¼dD� nBM� ©center® …dz«b�« e�d� b¹b×ð

 Æ©diameter® U¼dDI� …dz«b�« e�d� b¹b×ð
 Æ…dz«bK� Î«dD� ÊöJA¹ ¨…dz«b�« jO×� vKŽ sO²DI½ b¹b×ð

 ÆÂuÝd� YK¦� ”Ëƒ— w� dLð …dz«œ rÝ—√ ¨Îö¦� Æ…dz«b�« jO×� vKŽ ◊UI½ ÀöŁ b¹b×ð
ÆU¼dD� nB½ b¹b×ðË ¨…dz«bK� sOÝUL� ¡UI²½«

 ÆÂuÝd� YK¦L� WŁö¦�« Ÿö{_« fLð …dz«œ rÝ—√ ¨Îö¦� Æ…dz«bK�  UÝUL� WŁöŁ ¡UI²½«

rÝd�« kHŠ

 b¹b−�«  rÝô« d²š«  ÆFile>Save As  b¹bł nKL� tEHŠ«  Ë√  …b¹b−�«  tðö¹bFð  l� r¹bI�«  pHK� kHŠ«
  ÆœU�uðË√ oKž√ ÆDesktop:\ACAD2013\LESSON2

 s¹—ULð
 tEHŠ«Ë Æ`O×� bŠ«Ë v�≈ rÝd�« W�œ œbŠ Æ÷dF�UÐ W�—u� rÝd�« œËbŠ d�_UÐ ÁœËbŠ · ÒdŽ Î̈«b¹bł ÎUHK� `²�≈
 ∫WO�U²�« rÝd�« d�«Ë√ l³²ð ÆrÝd�« w�  A  rŁ Z   Âb�²Ý≈ ¨·ËdF� ÌbK−� sL{ EA2 rÝôUÐ Save As d�_UÐ

 ©≤π∑ ¨∞® ¨©≤π∑ ¨≤±∞® ¨©∞ ¨≤±∞® ◊UIM�« w� d1Ë ©∞¨∞® WDIM�« s� √b³¹ Íc�« rOI²�*« j)« rÝ—√  ±
 ÆW¹«b³�« WDI½ v�≈ œuF¹ rŁ

 Æ©π∞¨ ±∏∞® WDIM�« w� wN²M¹Ë ©π∞ ¨≤∞® WDIM�« s� √b³¹ ÎULOI²�� ÎUDš rÝ—√  ≤
 Æ©±μ∞ ¨±∏∞® WDIM�« w� wN²M¹Ë ©π∞ ¨≤∞® WDIM�« s� √b³¹ ÎULOI²�� ÎUDš rÝ—√  ≥

 ÆwI�_« sŽ ≥∞ qO1Ë ©π∞ ¨≤∞® WDIM�« s� √b³¹ rK�±∏∞ t�uÞ ÎUDš rÝ—√  ¥
 Æ©±≤∞ ¨±μ∞®v�Ë_« WDIMK� W³�M�UÐ WO½U¦�« t²DI½  UOŁ«bŠ≈Ë ©π∞ ¨≤∞® WDIM�« s� √b³¹ ÎUDš rÝ—√  μ

ÆrK� ±μ∞ t�uÞ ÊuJ¹Ë ©π∞ ¨≤∞® WDIM�« s� vKŽú� ÎUOÝ√— ÎUDš rÝ—√  ∂
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∏±

 UN²LÝ— w²�« ◊uD)« lOLł Ê√ Êü« b�Qð Æ©≤π∞ ¨≤∞∞® Ë ©±∞ ¨±∞® 5²DIM�« w� d1 ÎöOD²�� rÝ—√  ∑
ÆqOD²�*« «c¼ qš«œ UIÐUÝ

Æ©¥μ ¨¥¥® WDIM�« s� ÎU�öD½≈ ÎUOÝ√— rK� ≤∞∞ Ë ÎUOI�√ rK� ±∞∞ tŽö{√ Î«b¹bł ÎöOD²�� rÝ—√  ∏
 ÆrK� ∏∑ U¼dD� nB½Ë ©π∞¨π∞® U¼e�d� …dz«œ rÝ—√  π

 ÆrK� ±±∑ U¼dD�Ë ©π∞¨π∞® U¼e�d� …dz«œ rÝ—√  ±∞
 Æ©A©∑∞¨ ≥∞®¨ B©±≤∞¨ ≥∞ tðbŽU�  UOŁ«bŠ≈ Íc�« ABC Ÿö{_« ÍËU�²*« YK¦*« rÝ—√  ±±

  ÆoÐU��« YK¦*« …bŽUIÐ UNFOLł „d²Að YO×Ð w½ULŁ qJý W¹UG� ¨ÆÆÆ¨lÐd� ∫WO�U²�«  UFKC*« rÝ—√  ±≤
 Æqš«b�« s� tŽö{√ f9 Èdš√ …dz«œ rÝ—√Ë ¨oÐU��« YK¦*« ”Ëƒ— w� d9 …dz«œ rÝ—√  ±≥

ÆWŁö¦�« ”Ëƒd�« w� d1 ”u� rÝ— »dł  ±¥
 Æqš«b�« s� tŽö{√ f9 Èdš√ …dz«œ rÝ—√Ë ¨oÐU��« YK¦*« ”Ëƒ— w� d9 …dz«œ rÝ—√  ±μ

ÆWŁö¦�« ”Ëƒd�« w� d1 ”u� rÝ— »dł  ±∂
ÆœU�uðË√ oKž«Ë ¨wÝUOI�«  «Ëœ_« j¹dý s� Save —e�« dIMÐ Wz—UD�«  «dOG²�« kHŠ≈  ±∑

 ∫WFł«dLK� WK¾Ý√

 XDG{ rŁ  d??�«Ë_«  …c�U½  w�  C  ·d×�«  X³²�  «–≈
 C  ·d×�«  X�b�²Ý« «–≈Ë ÆZ²M¹  «–UL� ‰Ušœù« ÕU²H�

ÆZ²M¹ «–UL� Line jš rÝd�« d�_ „cOHMð bMŽ
 —U�OK� sOLO�« s� Áœb×ð Íc�« —UÞù« sOÐ ‚dH�« U�
 „—UO²š« bMŽ sOLOK� —U�O�« s� Áœb×ð Íc�« —UÞù« vKŽ

 ÆWýUA�« vKŽ  UMzU� WŽuL−L�

 W�bÐ rÝd�«                  
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∏≤

rÝd�« w� —U×Ðô« ∫Y�U¦�« ”—b�«
oÐUÝ nK� `²�

 ©Desktop:\ACAD2013\LESSON2 Í√ w½U¦�« ”—b�« w� pLÝ— tÐ XON½√ Íc�« nKL�«® r¹b� nK� `²H�
 œbŠ ÆSelect File —«u×�« lÐd� v�≈ qšbð sO²�U×�« w� p�H½ b−²� File>Open d²š« Ë√ Open d�_« V²�«
 ¨LESSON2 »uKDL�« nKL�« —U²�½ rŁ Desktop>ACAD2013 kH×�« bK−� Select File —«u×�« lÐd� w�

Æ©±∏® qJý w� dNE¹ UL�

Select File —«u×�« lÐd� ∫©±∏® qJý

 Zoom rÝd�« w� —U×Ðù«

 Ë√ tLÝd½ U� vKŽ WÐdI� …dE½ ¡UI�ù Âb�²�¹ œU�uðË√ w� ÎôULF²Ý« d�«Ë_« d¦�√ bŠ√ u¼ rÝd�« w� —U×Ðù«
 UM� `O²¹ ·uÝ Zoom ¢bOF³ðØV¹dIð¢ ?Ð t�dFMÝ Íc�« d�_« «c¼ ÆWIÐU��« WM¹UFL�« v�« …œuF�« WO½UJ�≈ l� tOM³½

 ∫UNL¼√  «—UOš …œbFÐ rÝd�« w� —U×Ðù«
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∏≥

 ∫rÝd�« s� WOŠU½ ‰uŠ Zoom Window WM¹UF*« V¹dI²�  √ 

∫w¼Ë p�– qLF� ‚dÞ …bŽ „UM¼
 d�«Ë_« …c�U½  w� dNEO� ¨wÝUOI�«   «Ëœ_« j¹dý s�   Zoom Window  ¢—UÞ≈ V¹dIð ¢ —e�«  jGCÐ  ±
 ?Ð œU�uðË√ VO−²�O� dýRLK� d�¹_« —e�UÐ dIM�UÐ p�–Ë —UÞû� Specify first corner ¢v�Ë_« W¹Ë«e�« d²š«¢
 p� dNEðË WýUA�« tðœbŠ Íc�« —UÞù« úLOÝ ÌczbMŽ WKÐUI*« W¹Ë«e�« d²š« Í√ ¨:Specify opposite corner

 ∫ÁU½œ√ …—u�c*« Èdš_« ‚dD�UÐ t�H½ »uKÝ_UÐ V¹dI²�« sJ1 UL� Ætðd²š« Íc�« —UÞù« qš«œ …d³J� WM¹UF*«
  Æd�«Ë_« …c�U½ w� W  rŁ  Z  WÐU²JÐ  ≤

ÆWindow ¢ —UÞ≈¢ rŁ  Zoom ¢V¹dIð” View WOÝUOI�« WLzUI�« s� dIM�UÐ  ≥

 ∫Zoom Previous WIÐU��« WM¹UF*« v�≈ …œuFK�  »

wÝUOI�«  «Ëœ_« j¹dý s�   Zoom Previous ¢oÐU��« V¹dIð¢ —e�« jGCÐ  ±
ÆP  rŁ  Z  WÐU²JÐ  ≤

 v�≈  œU�uðË√  œuFO�  View>Zoom>Previous  Í√  View  WOÝUOI�«  WLzUI�«  s� ¢oÐU��«  V¹dIð¢ dIM�UÐ  ≥
ÆsOLO�« vKŽ ©±π®  qJý ¨WIÐU��« WM¹UF*« ÷dŽ

∫Zoom Realtime wIOI(« bOF³²�«ØV¹dI²�« Â«b�²Ý«  ?ł

 ÆwÝUOI�«  «Ëœ_« j¹dý s�  ¢wIOIŠ bOF³ð ØV¹dIð¢ —e�« jGC�UÐ  ±
 Æ5LO�« vKŽ ©±π® qJý ¨WO�Ozd�« WLzUI�« s� ¢wIOIŠ bOF³ðØV¹dIð¢ d²š« Ë√ Z  WÐU²JÐ  ≤

 r??Ýd??�« ¡e???ł ‚u???� d??ýR??L??�« l??{ Æ± …—U????ý≈ l??� W??Ýb??Ž q??J??ý v???�≈ d??ýR??L??�« dOG²¹ s??O??²??�U??×??�« U²K� w???�Ë
ÆbF²³¹  Áb−ð  vKŽ√  v??�≈  V×Ý«Ë  dI½«  rŁ  ¨»d²I¹  rÝd�«  b−ð  qHÝ√  v??�≈  V×Ý«Ë  dI½«  rŁ  t³¹dIð  »uKDL�«

∫ Pan Realtime  wIOI(« ‰u−²�« Â«b�²Ý«  œ 

ÆwÝUOI�«  «Ëœ_« j¹dý s�  ¢wIOI(« ‰u−²�«¢ —“ jGCÐ  ±
 Æ—U�O�« vKŽ ©±π® qJý ¨WO�Ozd�« WLzUI�« s� ¢wIOIŠ ‰u&¢ dIMÐ  ≤

 sOLO�« v�≈ V×Ý«Ë dI½« rŁ rÝd�« jÝË ‚u� dýRL�« l{ Æb¹ qJý v�≈ dýRL�« dOG²¹ sO²�U×�« U²K� w�Ë
 ÆrÝd�« qO�UHð s� b¹eL�« —UNþù qHÝ_« Ë√ —U�O�« Ë√ vKŽ_« Ë√
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∏¥

     
©±π® qJý

 bOF³ðØV¹dIð ¨ Zoom Previous  oÐU��« V¹dIð UNM�Ë View  WOÝUOI�« WLzUI�« sOLO�« vKŽ ∫©±π® qJý
 ÆZoom Realtime  wIOIŠ

Pan Realtime  wIOI×�« ‰u−²�« Â«b�²Ý« —U�O�« vKŽ 

∫Zoom All qJ�« bOF³ðØV¹dIð Â«b�²Ý«  ?¼

 ÆrÝd�« —UÞ≈ sL{ tLÝdÐ XL� U� q� dNE¹ YO×Ð WM¹UFL�« bOF³ð Ë√ V¹dI²Ð œU�uðË√ ÂuI¹ ¨A rŁ Z  V²�«
ÆÎUIÐUÝ ÁU½œ—Ë√ UL� Limits d�_«Ë rÝd�« œËbŠ n¹dFð bMŽ Â«b�²Ýù« WFzUý W�U×�« Ác¼

Æ`OðUHL�« WŠu� s� Esc ÕU²HL�« jG{« œU�uðË√ w� —U×Ðù« d�«Ë√ s� Ìd�√ Í√ s� ÃËd�K� ∫WEŠö�

©Ortho® b�UF²�« j/ Â«b�²Ý«
 Ë√ØË WOI�√ ô≈ dýRLK� W�dŠ b−ð ö� ÆrÝd�« WOKLŽ w� YK¦�Ë T …dD�� Â«b�²Ý« bOFÐ ÌbŠ v�≈ t³A¹ jL½

Æ©≤∞® qJý ¨jI� W¹œuLŽË WOI�√ ◊uDš rÝ— vKŽ dýRL�« ©ortho® b�UF²�« jL½ d³−¹Ë ÆWOÝ√—
 ÎUC¹√ p�– oOI×ð pMJL¹Ë ¨ÎÎö ÒFH� ÊU� «–≈ tKODFð Ë√ Îö ÒDF� ÊU� «–≈ b�UF²�« jL½ qOFH²Ð F8 ÕU²HL�« ÂuI¹

 ÆW�U×�« j¹dý w�  —e�« vKŽ dIM�UÐ Ë√ ¨CTRL+L wŠU²H� vKŽ jGC�UÐ

Status bar W�U×�« j¹dý ∫©≤∞® qJý
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∏μ

Direct Distance Entry   ◊uD)« rÝd� …dýU³*« WI¹dD�«

 «cN�Ë ÆWOÝ√— U�≈Ë  WOI�√  U�≈  dýRL�«  W�dŠ `³Bð  —e�«  vKŽ jGC�UÐ  b�UF²�«  jL½  q =F ÓHÔ½  U�bMŽ
 s� dýU³� ÌqJAÐ  U�U�L�« rOIKðË dýRL�« s� ÁU−ðù« b¹b×²Ð WOÝ√d�«Ë WOI�_« ◊uD��« rÝ— W�uN�Ð UMMJL¹

 Æ`OðUHL�« WŠu�

 ∫‰U¦�

 Â«b�²ÝUÐ p�–Ë Èd�O�«Ë vKH��« t²¹Ë«“ s� ÎU�öD½≈ ±∞∞×μ∞ ÁœUFÐ√ qOD²�� rÝd� WO�U²�«  ULOKF²�« l³ð«
 ¢jš rÝ—¢ ÍœU�uðË_« d�_«

Command: Line 

Specify first point:         v�Ë_« WDIM�« œbŠ 

 bOFÐ ©p�– q³� v²Š Ë√ œU�uðË√ d�√ cOHMð ¡UMŁ√ Ìl{Ë Í√ w� tKODFð Ë√ tKOFHð sJL¹® b�UF²�« jL½ UM¼ q =F ÓHÔ½
 W¹«b³�« WDI½ sOL¹ v�≈ dýRL�« tłË ÆWOÝ√— Ë√ WOI�√ dýRL�« W�dŠ `³B²� j��« pLÝd� v�Ë_« WDIM�« b¹b×ð
V²�« rŁ —U�O�« v�≈ dýRL�« tłË rŁ ±∞∞ V²�«Ë vKŽ_« v�≈ dýRL�« tłË rŁ μ∞ V²�« rŁ UNM� XIKD½« w²�«

 «cJ¼ ÆC V²�« rŁ μ∞ 
Specify first point:<Ortho on>       v�Ë_« WDIM�« œbŠ  

Specify next point or [Undo]: 50          sOLOK� dýRL�«
Specify next point or [Undo]: 100          vKŽú� dýRL�«
Specify next point or [Close/Undo]: 50        —U�OK� dýRL�«
Specify next point or [Close/Undo]: C  

 Æ…bŠË ±∞∞ tŽUHð—«Ë …bŠË μ∞ t�uÞ ¨tMOFÐ qOD²�� u¼ t²LÝ— U� Ê√ V�UD�« Íe¹eŽ kŠöð
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∏∂

 s¹—ULð
  Direct Distnce Entry◊uD��« rÝd� …dýU³L�« WI¹dD�«  Â«b�²ÝUÐ  ©≤±® qJý ¨WOðô« ‰UJý_« rÝ—«

sOKJA�« rÝd� b�UF²�« jL½ Âb�²Ý« ∫©≤±® qJý

∫ ◊UA½

ÆÎUC¹√  UOŁ«bŠù« Â«b�²ÝUÐ ‰UJý_« Ác¼ rÝ—«

∫tO³Mð

 WNł s� sJ� ÆWIKDL�« UNLO� œb×ð w²�«  U�U�L�UÐ WOÝ√—Ë WOI�√ ◊uDš rÝ— vKŽ „bŽU�¹ b�UF²�« jL½ qOFHð 
  ÆWO³�M�«  UOŁ«bŠû� ÎUI�Ë pLO� XKšœ√ U� «–≈  U¼U−ðùUÐ Â«e²�ù« ÂbŽ b�UF²�« jL½ qOFHð l� pMJL¹ ¨Èdš√
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∏∑

Object Snap  UMzUJ�« VŁË

 v�≈ Ãu�u�« w� UMðbŽU�L�  UMzUJ�« VŁË Â«b�²Ý« qBH�« «c¼ w� rKF²²Ý
 w� WOL¼_« WG�UÐ …«œ√ w¼ ¢ UMzUJ�« VŁË ¢ …«œ_« Ác¼ ÆWMOFL�« WOÝbMN�« WDIM�«
 …dz«œ W¹√ ôË ÁUMLÝ— jš Í√ jÐd½ Ê√ ‰ËU×½ r� WIÐU��« ”Ë—b�« wH� ÆœU�uðË√
 U¼e�d� ÊuJ¹ …dz«œ rÝdÐ Vždð p½√ qO�ð ÆWýUA�« vKŽ …œb×� ◊UI½ l� W−ðU½
 nO� Ædš¬ jš l� tFÞUIð WDI½ Ë√ tHB²M� Ë√ WýUA�« vKŽ ÂuÝd� jš W¹UN½ WDI½
 VŁu�« ◊UL½√ Â«b�²ÝUÐ u¼ »«u−�« ÆœU�uðË√ w� ÁcOHMð r²¹ nO�Ë p�– qLF½
 ◊UIM�« v�≈ VŁu�« vKŽ dýRL�« d³−¹ YOŠ fOÞUMGL�« t³Að w²�«Ë Object Snap

Æa�«ÆÆÆ”uI�« Ë√ j��« nB²M� Ë√ …dz«b�« e�dL� …œb×L�« WOÝbMN�«

 Â«b�²Ý« w¼ wÝUOI�«  «Ëœ_« j¹dý w� VŁu�« jL½ qOFH²� WI¹dÞ qC�√
 WLzUI�« Ác¼ vKŽ jGC�« r²¹ –≈ Æ©≤≤® qJý ¨VŁu�« ◊UL½√ s� WŽdH²L�« WLzUI�«

 Æ»uKDL�« VŁu�« jL½ UNM� —U²�½ rŁ UNz«eł√ q� qHÝú� ŸdH²ð Í√ ‰b�M²�
 VŁu�« ◊UL½√ WLzU� ∫©≤≤® qJý

  «Ëœ_« j¹dý s� WŽdH²L�«
wÝUOI�«

 WI¹dD�« Ác¼ Æ©≤≥® qJý ¨dL²�� qJAÐ WýUA�« vKŽ t²O³¦ðË VŁu�« ◊UL½√  «Ëœ√ j¹dý qOFHð sJL¹ UL�
 w� WOKLŽ d¦�_« w¼ ¨Èdš√ WNł s� UNMJ� ¨WýUA�« vKŽ Î«eOŠ qGA¹  «Ëœ_« j¹dý Ê_ UN�«b�²Ý« qCH¹ ô
 ¢÷dŽ¢ WLzU� s� ToolbarsÆÆÆ¢ «Ëœ_« WÞdý√¢ d²š« ¨p�cÐ ÂUOIK� Æœb−�« sOLKF²LK� W�Uš Â«b�²Ýô«
 VŁu�« ◊UL½√ j¹dý dNEO� ¨©Object Snap® ¢ UMzUJ�« VŁË¢  Customize  —«u×�« lÐd� s� d²š«Ë ¨View

Æ©≤≥® qJý w� UL�

Object Snap VŁu�« ◊UL½√ j¹dý ∫©≤≥® qJý
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∏∏

W¹eOK$ô« WGK�UÐ UNð«—UB²š«Ë  UMzUJ�« VŁË vMF�Ë  «—UOš

 ∫UNM� …bŠ«Ë q� vMF�Ë  UMzUJ�« VŁË  «—UOš r¼_ Õdý wK¹ ULO�
.a�«ÆÆÆ”u� Ë√ jš W¹UN½ v�≈ dýRL�« VŁË vKŽ ENDpoint W¹UNM�« WDI½ v�≈ VŁu�« bŽU�¹

.a�«ÆÆÆ”u� Ë√ jš nB²M� v�≈ dýRL�« VŁË vKŽ MIDpoint nB²ML�« WDI½ v�≈ VŁu�« bŽU�¹
ÆsOFÞUI²� sOMzUJ� WOKF� lÞUIð WDI½ v�≈ dýRL�« VŁË vKŽ INTersection lÞUI²�« v�≈ VŁu�« bŽU�¹

 ÊUMzU� UNO� lÞUI²¹ w²�« WDIM�« v�≈ dýRL�« VŁË vKŽ APParent intersection d¼UE�« lÞUI²�« v�≈ VŁu�« bŽU�¹
ÆUL¼U½œ Òb� u� ULO�

ÆÁU½œ Òb� u� ULO� szUJ�« qJý Áœb×¹ Íc�« ÁU−ðô« w� wAL¹ dýRL�« qFł vKŽ EXTension œ«b²�ô« v�≈ VŁu�« bŽU�¹
Æa�«ÆÆÆ”u� Ë√ …dz«œ e�d� v�≈ dýRL�« VŁË vKŽ CENter e�dL�« v�≈ VŁu�« bŽU�¹

Æ—ËU×� l� ”uI�« Ë√ …dz«b�« lÞUIð l�u� v�≈ dýRL�« VŁË vKŽ QUADdrant …dz«b�« lÐ— v�≈ VŁu�« bŽU�¹
ÆÍdz«œ ”u� Ë√ …dz«œ vKŽ ”ULL�« l�u� v�≈ dýRL�« VŁË vKŽ TANgent ”ULL�« v�≈ VŁu�« bŽU�¹

ÆY W¹œUB�«Ë X WOMO��«  UOŁ«bŠù«
 rÝd¹ YO×Ð ”u� Ë√ …dz«œ Ë√ jš vKŽ l�u� v�≈ dýRL�« VŁË vKŽ PERpendiclar b�UF²L�« v�≈ VŁu�« bŽU�¹

 Æ”uI�« p�– Ë√ …dz«b�« pKð Ë√ j��« p�– vKŽ Î«b�UF²� ÎUDš
Æjš ÁU−ðô ÎU¹“«u� wAL¹ dýRL�« qFł vKŽ PARallel Í“«uL�« v�≈ VŁu�« bŽU�¹

Æ©block® WK²J�« Ã«—œ≈ WDI½ Ë√ WÐU²JK� q�_« WDI½ v�≈ dýRL�« VŁË vKŽ INSertion Ã«—œù« v�≈ VŁu�« bŽU�¹
ÆÂuÝdL�« qJA�« jI½ s� WDI½ v�≈ dýRL�« VŁË vKŽ NODe …bIŽ v�≈ VŁu�« bŽU�¹

∫WEŠö�

 ·Ëd×�UÐ  ÁöŽ√ …œ—«u�«   «—UB²šù« V²Jð Ê√  d�«Ë_« …c�U½  w� VŁu�«  ◊UL½_ p�«b�²Ý« bMŽ lOD²�ð
 ÆjL½ qJ� …dO³J�« Àö¦�« W¹eOK−½ù«
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∏π

 tðU¹u²×�Ë rÝd�«  «Ëœ√ j¹dý ∫lÐ«d�« ”—b�«

Draw rÝd�« WLzU� ∫©≤μ® qJý Draw Toolbar rÝd�«  «Ëœ√ j¹dý ∫©≤¥® qJý

  «Ëœ√ j¹dý UM�b�²Ý« UL� ¨d�«Ë_« …c�U½ w� UN²ÐU²JÐ rÝd�« d�«Ë√ iFÐ vKŽ ”Ë—œ s� o³Ý ULO� UM�dFð
 rKFð UM¼ qLJMÝ Æ UFKCL�«Ë dz«Ëb�«Ë  öOD²�L�«Ë ◊uD��U� WOÝUÝ_« rÝd�« d�UMŽ iFÐ rÝd� rÝd�«
 WÝUOI�« WLzUI�« sL{ Ë√ ©≤¥® qJý ¨rÝd�«  «Ëœ√ j¹dý sL{ U�≈ …œb×L�«Ë …—uNAL�« rÝd�« d�«Ë√ VKž√

 Æ©≤μ® qJý ¨ Draw ¢rÝd�«¢

 ·dF²�« qLJMÝ ¨Êô« Æd�¹Ë W�uN�Ð œb×L�« d�_« ¡UI²½« vKŽ …bŽU�L�« v�≈ ·bN¹ rÝd�«  «Ëœ√ j¹dý
 ÎU�UC� Ellipse h�UM�« lDI�«Ë arc Ídz«b�« ”uI�«Ë point WDIM�U� œU�uðË√ w� …—uNAL�« rÝd�« d�«Ë√ WOIÐ vKŽ

 ÆSpline w×¹dA�« j��« rÝ—Ë MtextË Dtext œU�uðË√ w� ’uBM�« WÐU²� p�– v�≈
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π∞

Ídz«b�« ”uI�« rÝ—

 ”uI�«  v�≈  U½dE½  «–≈  Æ…œb×�  «—UO²šô ÎUI�Ë  tLÝ— sJL¹  …d??z«œ  s� Î«¡e??ł qJA¹ wÝbM¼ szU�  ”uI�«
 p�c�Ë Æ”uI�« rÝdðË ·dFð WLÝd�« vKŽ …œułuL�«  UODFL�« s� WŁöŁ W¹√ Ê√ b−½ ¨©≤∂® qJý ¨ÂuÝdL�«

 Æ”uI�« rÝd� ÎÓUÝUÝ√ qJA²�  UODFL�« Ác¼ s� WŁöŁ W¹√ jÐd½ Ê√ lOD²�½

 Ídz«b�« ”uI�« rÝ—  UODF�∫©≤∂® qJý

 ¨WOÝUOI�« WLzUI�« s� Ë√ ¨rÝd�«  «Ëœ√ j¹dý s� ”uI�« rÝ— sJL¹ œU�uðË√ d�«Ë√ VKž√ w� ‰U×�« u¼ UL�Ë
 d�«Ë_« …c�U½ w� WÐU²� v²Š Ë√ ¨©≤∑® qJý

 Draw WOÝUOI�« WLzUI�« s� Ídz«b�« ”uI�« rÝ—∫©≤∑® qJý
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π±

 ∫©≤∑® qJý dE½√ ¨Ídz«b�« ”uI�« rÝd� WMJLL�«  UL²Šù«
∫WOÝUOI�« WLzUI�« s� Ídz«b�« ”uI�« rÝd�

 Æ”uI�« vKŽ ◊UI½ ÀöŁ  
 ÆW¹UNM�« WDI½Ë ”uI�« e�d� ¨W¹«b³�« WDI½  

 ÆwÝuI�« ŸUDI�« W¹Ë«“Ë ”uI�« e�d� ¨W¹«b³�« WDI½  

 Æ”uI�« ‰uÞË ”uI�« e�d� ¨W¹«b³�« WDI½  
 ÆwÝuI�« ŸUDI�« W¹Ë«“Ë W¹UNM�«Ë W¹«b³�« w²DI½  

 ÁU&ô«Ë W¹UNM�«Ë W¹«b³�« w²DI½  
 ÆdDI�« nB½Ë W¹UNM�«Ë W¹«b³�« w²DI½  

 ÆW¹UNM�« WDI½Ë W¹«b³�« WDI½ ¨”uI�« e�d�  
 ÆwÝuI�« ŸUDI�« W¹Ë«“Ë W¹«b³�« WDI½ ¨”uI�« e�d�  

 Æ”uI�« ‰uÞË W¹«b³�« WDI½ ¨”uI�« e�d�  
ÆoÐUÝ ”u� Ë√ jš s� ”u� rÝ— WFÐU²�  

Spline w×¹dA�« j)«

 Ác¼ sOÐ  jÐd�UÐ  tLÝ— r²¹Ë ÕuD��«  Ë√   UOM×ML�«  n�u� w{U¹— dO³F²� …œb×� ◊UI½  jÐd¹  Ìs×M� jš
   ÆWýUA�« vKŽ ÂuÝd� lÐd� ©”Ëƒ—® ◊UI½ sOÐ jÐd¹ ÎUO×¹dý ÎUDš rÝdð Ê√ ‰ËUŠ Æ◊UIM�«

Command: Spline  

Specify first point or [Object]:       v�Ë_« ©”√d�«® WDIM�« dI½«
Specify next point:            WO½U¦�« WDIM�« dI½«
Specify next point or [Close/Fit tolerance] <start tangent>:       W¦�U¦�« WDIM�« dI½«
Specify next point or [Close/Fit tolerance] <start tangent>:     WFÐ«d�« WDIM�« dI½«
Specify next point or [Close/Fit tolerance] <start tangent>: C  (Close) 

Specify tangent: 

 ÊUHK²�� ULNMJ� WFÐ—_« lÐdL�« ◊UI½ s� dLð w²�« …dz«b�« s� »d²I¹ ÂuÝdL�« w×¹dA�« vM×ML�« Ê√ b¼UA²Ý
  ÆWHK²�L�« VŁu�« ◊UL½√ Â«b�²ÝUÐ r²¹ b� jIM�« —UO²š« Ê√ v�≈ ÁU³²½ù« V−¹ ÆÈdš√  UH� w�
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π≤

 h�UM�« lDI�« Ë√ ÍËUCO³�« qJA�« rÝ—

 sO²DIM�« sOÐ W�U�L�« Æt� ÎUŽUÐ—√ qJAð ◊UI½ lÐ—√ s� tOKŽ ◊UI½ ÀöŁ b¹b×²Ð ÍËUCO³�« qJA�« rÝ— r²¹
 Minor Íu½U¦�« —u×L�« dD� nB½ W¦�U¦�« WDIM�« dIMÐ œb×½Ë Major axis d³�_« —u×L�« qJAð WO½U¦�«Ë v�Ë_«

 ÆÂuÝd� qOD²�� Ÿö{√  UHBM� qJAð ÀöŁ ◊UI½ w� dL¹ Íc�« ÍËUCO³�« qJA�« rÝ—« ÆAxis

 ÍËUCO³�« qJA�« rÝ— ∫©≤∏® qJý

Command: Ellipse 

Specify axis endpoint of ellipse or [Arc/Center]: MID of  sOLO�« vKŽ qOD²�L�« lK{ nB²M� dI½«
Specify other endpoint of axis: MID of        —U�O�« vKŽ qOD²�L�« lK{ nB²M� dI½«
Specify distance to other axis or [Rotation]:         vKŽ_« w� qOD²�L�« lK{ nB²M� dI½«

∫‰U¦�

 Æ…bŠË μ∞ dG�_« Á—u×� ©‰uÞ®Ë …bŠË ±∞∞ d³�_« Á—u×� ©‰uÞ® Íc�« ÍËUCO³�« qJA�« rÝ—«
Command: Ellipse 

Specify axis endpoint of ellipse or [Arc/Center]:      WýUA�« vKŽ U� WDI½ dI½« 
Specify other endpoint of axis: @100<0 

Specify distance to other axis or [Rotation]: @25<90 
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π≥

∫w�U²�« ‰U¦L�« w� UL� Áe�d� s� bO�UÐ ÍËUCO³�« qJA�« rÝ— sJL¹Ë UL�
∫‰U¦�

Æ…bŠË ∂∞ dG�_« Á—u×� ©‰uÞ®Ë …bŠË ±≤∞ d³�_« Á—u×� ©‰uÞ® Íc�« ÍËUCO³�« qJA�« rÝ—«
Command: Ellipse 

Specify axis endpoint of ellipse or [Arc/Center]:  C          e�d�¢ —UO��« œb×½¢
Specify center of ellipse:       ÍËUCO³�« qJAK� wÝbM¼ e�dL� WýUA�« vKŽ U� WDI½ dI½« 
Specify endpoint of axis: @60<0             d³�_« dDI�« nB½ ‰uD� sOLO�« vKŽ WDI½ vB�√ œbŠ
Specify distance to other axis or [Rotation]: @30<0   

 dG�_« dDI�« nB½ ‰uD� vKŽ_« w� WDI½ vB�√ œbŠ

 Hatch qOKE²�« d�√

 WŽuL−� vKŽ œU�uðË√ Íu²×¹ –≈ Æ…œb×� qOKEð Ã–UL½Ë ◊UL½√ o�Ë WIKGL�«  UŠU�L�« qOKE²Ð d�_« «c¼ ÂuI¹
 Hatch —e�« dI½ Ë√ Draw>Hatch WO�Ozd�« WLzUI�« s� Hatch d�_« q =F ÓHÔ½Ë ¨©Hatch pattern® qOKE²�« Ã–UL½ s�

 ∫V²J½ Ë√ rÝd�«  «Ëœ√ j¹dý s�
Command: Bhatch ( Bh )

∫ UNM� —U²�M� Boundary Hatch qOKE²�« œËbŠ —«u×�« lÐd� v�≈ p�– pKšb¹

¢qOKE²�« œËbŠ¢—«u×�« lÐd� ∫©≤π® qJý
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π¥

 User defined —U²�M� Type ¢jLM�«¢
 Wł—œ ¥μ —U²�½ Angle  ¢W¹Ë«e�«”

 …bŠË ≤[μ œb×M� Spacing qOKE²�« ◊uDš sOÐ ¢W�U�L�«¢
 qOKE²�« WIDML� ÎUO�Ë√ Î«dEM� cšQ½ Ê√ p�– bFÐ lOD²�½Ë ÆqKE²Ý w²�« WŠU�L�« eOŠ qš«œ WDI½ —U²�½ rŁ
 ‰Ušœù« ÕU²H� jGC½ UMðU³KÞ l� WI�«u²� WLIKL�«  UODFL�« Ê√ U½błË «–≈ ÆqHÝ_« w� Preview —e�« vKŽ dIM�UÐ

  ÆsOLO�« vKŽ OK

 ’uBM�« ‰Ušœ≈

∫UL¼ sO²MŁ« sO²GOBÐ œU�uðË√ w� ’uBM�« ‰Ušœ≈ r²¹
Dtext d�_UÐ Single Text  œdHM� jš

 √b³ð  …œUF�UÐË Æl³Dð U�bMŽ W×{«Ë WÐU²J�«  ÊuJðË ÆbŠ«Ë WÐU²� jš s� d¦�√  rÝdÐ d�_« «c¼ p� `L�¹
 hMK� Èd�O�«Ë WOKH��« W¹Ë«e�« w� ÎUO{«d²�« œb×²ð w²�«Ë Start Point ¢W¹«b³�« WDI½¢ w¼ WMOF� WDI½ s� WŽU³D�«

       ÆW¹«b³�« ◊UL½√ s� Í√ —UO²š« r²¹ Ë√
Command: dt 

DTEXT

Current text style:  “ARIAL”  Text height:  3

Specify start point of text or [Justify/Style]:    hM�« W¹«bÐ WDI½ U½œbŠ UM¼
Specify height <3>:             «bŠË ≥ ?Ð œb×ð WÐU²J�« ŸUHð—«
Specify rotation angle of text <0>:

Enter text: SIGLE TEXT1 

Enter text: 

Mtext d�_UÐ Multiline Text …dI� jš
 lOD²�ðË ÆqOD²�L� ÎUHKÝ œb×ð  UŠU�� sL{ ‰Ë«b−�«Ë  «dIH�«Ë qL−�« WÐU²JÐ d�_« «c¼ p� `L�¹
 sL{ WÐU²J�« dNEð ÆdDÝ UN²×ð Ë√ WHK²�� WOB½ ◊UL½QÐ Ë√ WKzU� ◊uD�Ð  ULK� V²Jð Ê√ ◊UL½_« bŠ√ sL{

  Æ(Multiline text editor) Mtd�_« oO³D²� WI�«d� WOB½ WýUý
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πμ

∫s¹—ULð
∫WO�U²�« ‰UJý_« rÝ—√

±

≤

≥
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π∂

∫q¹bF²�«  «Ëœ√ j¹dý ∫f�U��« ”—b�«
  ¨rÝd�«  «Ëœ√ j¹dýË rÝd�« d�«Ë√ vKŽ ”Ë—œ s� o³Ý ULO� UM�dFð
 ÊuJL�«Ë Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý vKŽ ·dF²�« UM¼ ‰ËU×MÝ
 bŠ«Ë ÌwÝUÝ√ Ìd�√ vKŽ UM�dFð b�Ë Æ©≥∞® qJý ¨ÎUOÝUÝ√ Î«—“ ±∂ s� ÎUC¹√
 vKŽ ·dF²�« qLJMÝ ¨Êô«Ë ÆErase szUJ�« ·cŠ u¼Ë q¹bF²�« d�«Ë√ s�
 Mirror  ”UJF½ù«Ë Copy a�M�U� œU�uðË√ w� …—uNAL�« q¹bF²�« d�«Ë√ WOIÐ
 Rotate d¹Ëb²�« rŁ Move p¹d×²�«Ë Array W�uHBL�«Ë Offset WŠ«“ù«Ë
 ¨Trim hI�« ¨Lengthen b¹bLð ¨Stretch jL�« ¨Scale rÝd�« ”UOI�Ë
  W¹Ë«eÐ nDA�« Break at point WDI½ w� lDI�« ¨Extend W�U×� b¹bL²�«
 ‰uB×�« sJL¹ UL� ÆExplode pOJHð rŁ Fillet  W�U×Ð d¹Ëb²�«Ë Chamfer

 Æ©≥±® qJý ¨Modify WOÝUOI�« WLzUI�« s� d�_« «c¼ vKŽ

 Modify WOÝUOI�« WLzUI�« ∫©≥±® qJý Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý ∫©≥∞® qJý

Copy  a�M�«

 v�≈ UNKLŠË t� W¾�UJ� wK�_« qJA�« s� Èdš√ W��½ ¡UA½≈ vKŽ d�_« «c¼ ÂuI¹
 Æ UOŁ«bŠùUÐ …œb×� l�«u� w� UNF{uÐ Ë√ rÝd�« WýUý vKŽ dIM�UÐ U�≈ Èdš√ l�«u�
 vKŽ ‰uB×�« sJL¹ UL� ©Co  dB²�� ÌqJAÐ Ë√  Copy V²�«® a�M�« d�√ q =F ÓHÔ½

ÆqÐUIL�« qJA�« w� UL� ¨ Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý s� d�_« «c¼

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



π∑

Command: Copy 

Select objects: Specify opposite corner: 1 found         »uKDL�« qJA�« dI½« 
Select objects:               —UO²šô« W¹UN½
Specify base point or displacement, or [Multiple]: int  

Æt� ”UÝ√ WDI½ ÊuJð Ê√ w� Vždð w²�«Ë t��½ »uKDL�« qJA�«  w� ◊UIM�« bŠ√ dI½«
Specify second point of displacement or <use first point as displacement>: 

 Œu�ML�« qJAK� b¹b−�« l�uL�« dI½«

Copy a�M�« ∫©≥≤® qJý

 Multiple Copy  —dJ²*« a�M�«

 rŁ wK�_« szUJ�« s� …b¹bł a�½ ¡UA½≈ vKŽ ÂuI¹ Copy wK�_« d�_« s� wŽd� d�√ u¼ —dJ²L�« a�M�«
 ‰U¦L�« ÆwK�_« d�_« ‚UOÝ sL{ Multiple —dJ²� —UO��« qOFHð vKŽ d�_« «c¼ ÂuI¹ Æq�_« V½U−Ð UNIB�

   …—dJ²� a�½ ¡UA½≈ UMMJL¹ nO� `{u¹ w�U²�«
Command: Copy 

Select objects: Specify opposite corner: 1 found     »uKDL�« qJA�« dI½« 
Select objects:         —UO²šô« W¹UN½
Specify base point or displacement, or [Multiple]: M     —dJ²� —UO��« q =F ÓHÔ½
Specify base point: int

 wK¹ UL� ”UÝ√ WDI½ ÊuJð ÊQÐ Vždð w²�«Ë t��½ »uKDL�« qJA�« w�  ◊UIM�« ÈbŠ≈ dI½« 
Specify second point of displacement or <use first point as displacement>: 
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π∏

 WÐU²� UNðUOŁ«bŠ≈ œbŠ Ë√ ÁöŽ√ ”UÝ_« WDI½ UNOKŽ o³DMð ÊQÐ Vždð w²�«Ë WýUA�« vKŽ  ◊UIM�« ÈbŠ≈ dI½«
 d�«Ë_« …c�U½ w�

Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�
Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�
Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�
Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�
Specify second point of displacement or <use first point as displacement>: ÁöŽ√ œ—Ë U� —d�
Specify second point of displacement or <use first point as displacement>:         ¡UN²½ö�

Multiple Copy  —dJ²L�« a�M�« ∫©≥≥® qJý

∫‰U¦�

 rOI²�L�« j��« vKŽ tð«– qJA�« s� Èdš√ ‰UJý√ WFÐ—√ lMBð YO×Ð rÝd�« WýUý vKŽ ÎU�uÝd� ÎöJý a�½«
∫wðQ¹ UL� q×�«  Æ…bŠË ±μ W�U�� ÁbFÐ Ë√ tK³� Íc�« sŽ sOFL�« qJA�« bF³¹ YO×Ð

Command: Copy 

Select objects: 1 found       t��½ »uKDL�« qJA�« dI½«
Select objects:   

Specify base point or displacement, or [Multiple]: M      —dJ²� —UO��« q =F ÓHÔ½
Specify base point:         Á ©tł—Uš v²Š Ë√® qJA�« w� WDI½ ÍQ� ”UÝ_« WDI½ œb×½
Specify second point of displacement or <use first point as displacement>: @15<0 

Specify second point of displacement or <use first point as displacement>: @30<0

Specify second point of displacement or <use first point as displacement>: @45<0

Specify second point of displacement or <use first point as displacement>: @60<0

Specify second point of displacement or <use first point as displacement>:   d�_« wNM½
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ππ

Mirror  ”UJF½ù«

 ”UJF½ù« jš qJA¹ jš v�≈ ÎUÝUO� t� W��UF� wK�_« qJA�« s� Èdš√ W��½ ¡UA½≈ vKŽ d�_« «c¼ ÂuI¹
 «c¼ vKŽ ‰uB×�« sJL¹ UL� ©Mi   dB²�� ÌqJAÐ Ë√  Mirror V²�«® ”UJF½ù« d�√ q =F ÓHÔ½  ÆMirror Line

Modify>Mirror WO�Ozd�« WLzUI�« s� v²Š Ë√ Modify Toolbar q¹bF²�«  «Ëœ√ j¹dý s� d�_«
Command: Mirror  

Select objects: Specify opposite corner: 1 found  5         »uKDL�« qJA�« dI½«
Select objects:                —UO²šô« W¹UN½
Specify first point of mirror line:                     ”UJF½ô« j�� v�Ë_« WDIM�« s� —U²�½ 
Specify second point of mirror line:              ”UJF½ô« j�� WO½U¦�« WDIM�« s� —U²�½
Delete source objects? [Yes/No] <N>:       q�_« ·cŠ w� p²³ž— ÂbF� ‰Ušœù« ÕU²H� jGC½

q³�

bFÐ

Mirror ”UJF½ô« ∫©≥¥® qJý

Offset WŠ«“ù«

 vKŽË q�ú� W¹“«u� szU� s� …b¹bł W��½ ¡UA½≈ vKŽ WŠ«“ù« d�√ √b³� ÂuI¹
 U�≈ WŠ«“ù« W�U�� b¹b×²� sO²O½UJ�≈ …œUF�UÐ Offset d�_« sL{ błu¹ ÆtM� œb×� bFÐ
V²�«® WŠ«“ù« d�√ q =F ÓHÔ½ ÆWýUA�« vKŽ …œb×� ◊UI½ sOÐ W�U�L�« b¹b×²Ð Ë√ ÂU�—_UÐ
 j¹dý s� d�_« «c¼ vKŽ ‰uB×�« sJL¹ UL� ©O  dB²�� ÌqJAÐ Ë√  Offset

Modify>offset WO�Ozd�« WLzUI�« s� Ë√ Modify Toolbar q¹bF²�«  «Ëœ√
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±∞∞

∫‰U¦�

 s� …bŠË ∑∞ bFÐ vKŽË dLŠ_« ◊uD��« œbF²L� ÎU¹“«u� dš¬Ë ÍËUL��« ‚—“_« j�K� ÎU¹“«u� ÎUDš rÝ—«
Æ©≥μ® qJý ÆsOMŁù«

Command: O 

OFFSET

Specify offset distance or [Through] <50>: 70 

Select object to offset or <exit>:            Í©ÍËUL��« ‚—“_« j��«® q�_« dI½«
Specify point on side to offset:                     ©sOLO�«® WŠ«“ö� Áb¹dð Íc�« V½U−�« vKŽ WDI½ œbŠ
Select object to offset or <exit>:                         Í©dLŠ_« j��«® q�_« dI½«
Specify point on side to offset:             tM� Èd�O�« t²Nł w� WDI½ dI½«
Select object to offset or <exit>:  

q³� bFÐ

WŠ«“ù« ∫©≥μ® qJý

 Move p¹d×²�«
 Â«b�²ÝUÐ dš¬ l�u� v�≈ w�U×�« UNF�u� s�  UMzUJ�«Ë d�UMF�« „d×ð Ê√ lOD²�ð œU�uðË√ w� pLÝ— bFÐ

 ∫WOðü« ‚dD�« ÈbŠ≈ d²š« p�cÐ ÂUOIK� ÆMove¢p¹d×ð¢ œU�uðË√ d�√
Æ©dB²�� qJAÐ m ® Ë√ Move  d�«Ë_« …c�U½ w� V²�«  

 Æq¹bF²�«  «Ëœ√ j¹dý s�  ¢ p¹d%¢ —“ d²š«  
 ÆModify>Move WOÝUOI�« WLzUI�« s� p¹d×²�« d�√ vKŽ ‰uB(« sJ1 UL�  

 dýRL�« —“ dI½« ¨d�«Ë_« …c�U½ w� Select object ¢ÎUMzU� d²š«¢ tłu� —uNþ bMŽË ¨ ôU×�« lOLł w�Ë
 szUJ�« Ë√ dBMF�« —UO²š« WOKLŽ ¡UN½ù  ‰Ušœù« ÕU²H� U¼bFÐ jG{« rŁ ÎUFDI²� `³BO� szUJ�« p�– vKŽ d�¹_«
 v�≈ szUJ�« «c¼ p¹d×²� UNO�≈ œUM²Ýô« UMMJL¹ w²�«Ë Base Point ”UÝ_« WDI½ UNL�½ WMOF� WDI½ œbŠ U¼bFÐË

 ∫w�U²�« q�K�²�« T�UJ¹ ULÐ tO�≈ tKIMÐ Vžd½ dš¬ ÊUJ�
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±∞±

Command: Move 

Select objects: Specify opposite corner: 1 found

 ÆbŠ«Ë dBMŽ œb×ð tOKŽË UNKIM²Ý w²�«  UMzUJ�« œbŠ Í√
Select objects:  

  jG{« Ë√ ¨ÎUI�«u� sL¹_« …—QH�« —“ dI½« „d×²²Ý w²�«  UMzUJ�« ¡UI²½≈ WOKLŽ ¡UN²½« bMŽ
Specify base point or displacement:          WMOF� ”UÝ√ WDI½ dýRL�UÐ dI½«  

 WDIM�« ÁcN�  UOŁ«bŠS� Ë√ dýRL�UÐ Î¡«uÝ WýUA�« vKŽ WDI½ œbŠ Í√
Specify second point of displacement or <use first point as displacement>:

 ÆUNðUOŁ«bŠ≈ Ë√ ¨”UÝ_« WDI½ tKB²Ý Íc�« b¹b−�« l�uL�« dýRL�UÐ dI½«

∫p¹d×²�« d�√ oO³D²� vK¦L�« WI¹dD�«

 q×ð WKJAL�« Ác¼ ÆMove p¹d×²�« d�√ cOHM²� ”UÝ_« WDI½ œb×¹ s¹√ b¹b×ð WKJA� Âb�²�L�« tł«uð
 w²�« Èdš_« WDIM�«  UOŁ«bŠ≈ b¹b×²Ð ÂuI½ rŁ s�Ë szUJ�« vKŽ WDI½ œb×ð –≈ ¨VŁu�« ◊UL½√ bŠ√ Â«b�²ÝUÐ

 ÆszUJ�« UN� qB¹ Ê√ V−¹

∫‰U¦�

 Æ…bŠË μ∞ W�U�� sOLO�« v�≈ ÎU�uÝd� ÎUFÐd� „dŠ
Command: Move 

Select objects: 1 found               lÐdL�« dI½« 
Select objects: 

Specify base point or displacement:   

  lÐdL�« U¹«Ë“ ÈbŠS� ”UÝ_« WDI½ b¹b×²� © UMzUJ�« VŁË j¹dý s�® lÞUIð VŁu�« jL½ œbŠ
Specify second point of displacement or <use first point as displacement>: @50<0 

 ÆsOLO�« v�≈ …bŠË μ∞ W�U�� U�d×ð lÐdL�«Ë ”UÝ_« WDI½ Ê√ b−²�
Èdš√ WI¹dDÐ q×�«

Command: Move 

Select objects: 1 found                lÐdL�« dI½« 
Select objects: 

Specify base point or displacement:     WýUA�« vKŽ WDI½ W¹√ dýRL�UÐ dI½« 
Specify second point of displacement or <use first point as displacement>: @50<0 

ÆsOLO�« v�≈ …bŠË μ∞ W�U�� „d×ð lÐdL�« Ê√ b−ð
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±∞≤

 ∫± `OLKð

 dýRL�UÐ U¼—UO²š« rð WýUA�« vKŽ WDI½ W¹√ d³²Fð –≈ Æ”UÝ_« WDI½ l�uL� oO�b�« b¹b×²�« w� m�U³½ ô Ê√ UMOKŽ
ÆÈdš√ …œb×� WDI½  UOŁ«bŠ≈ WÐU²� bMŽ ‰U×�« u¼ UL� ÎU�ULð b¹b×²�« ◊dA� WO�u²��

∫≤ `OLKð

 WŠ«“ù« Ë√ ”UÝ_« WDI½ b¹b×ð pM� VKD�«Ë dšü ÌÊUJ� s� UN�d×²Ý w²�« d�UMF�«ØdBMFK� „—UO²š« ‰UŠ
 szUJ�«ØdBMFK� „d×²�« W�U�� Í√ WŠ«“ù« —«bI� …dýU³� V²Jð Ê√ lOD²�ð Specify base point or displacement

 Æ”UÝ√ WDI½ w¼ UNO� Á—UO²š« rð w²�«Ë dBMFK� v�Ë_« dIM�« WDI½ Ê√ v�≈ Î«œUM²Ý«

 Rotate d¹Ëb²�«

  UMzUJ�«Ë d�UMF�« s� WŽuL−� W¹√ v²Š Ë√ szUJ�« Ë√ dBMF�« d¹Ëbð vKŽ d�_« «c¼ ÂuI¹
 Æ…œb×� q�√ WDI½ ‰uŠË WMOF� W¹Ë«eÐ

∫‰U¦�

 ÆP WDIM�« ¨tO� qzUL�« lKC�« nB²M� WDI½ ‰uŠ oπ∞ —«bILÐ —U�O�« vKŽ ÂuÝdL�« ·d×ML�« t³ý — =Ë Óœ

q³�
bFÐ

 szUJ�« d¹Ëbð ∫©≥∂® qJý

Command: Rotate  (Ro )

ROTATE

Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0

Select objects: 1 found            Ád¹Ëbð »uKDL�« ·d×ML�« t³ý ¨dBMF�« dIM½
Select objects:       —UO²šô« WOKLŽ ¡UN½ù ‰Ušœù« ÕU²H� jGC½ 
Specify base point: mid  of        ”UÝ√ WDIM� ·d×ML�« t³ý w� qzUL�« j��« nB²M� œb×½
Specify rotation angle or [Reference]: 90 

 ÆWŽU��« »—UIŽ fJFÐ …—Ëœ lÐ— —«bILÐ P WDIM�« ‰uŠ ·d×ML�« t³ý —ËbO�
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±∞≥

  Scale rÝd�« ”UOI�

 s� WŽuL−� W¹√ v²Š Ë√ dBMF�« ¨szUJ�« r−Š dOGBð Ë√ dO³Jð vKŽ d�_« «c¼ ÂuI¹
 Æ…œb×� WDI½ v�≈ W³�M�UÐ  UMzUJ�«Ë d�UMF�«

∫‰U¦�

 nBMK� …dz«b�« dG� bFÐ ULO� rŁ ¨PWDIM�« ‰uŠ 1.25 —«bIL�UÐ dLŠ_« ÊuK�UÐ ÂuÝdL�« ·d×ML�« t³ý dÒ³�
Æ·d×ML�« t³ý r−Š dOOGð ÊËœ U¼e�d� ‰uŠ

©≥∑® qJý

Command: Scale  (Sc )

Select objects: Specify opposite corner: 1 found    ·d×ML�« t³ý dIM½ 
Select objects:         d�UMF�« —UO²š« ¡UN½ù ‰Ušœù« ÕU²H� jGC½
Specify base point:            P WDIM�« w¼Ë ”UÝ√ WDI½ œb×½ 
Specify scale factor or [Reference]: 1.25 

 ÆP WDIM�« ‰uŠ 1.25 W³�MÐ r�Cð b� ·d×ML�« t³ý Ê√ b−M�
 s� u¼ UL� ·d×ML�« t³ý r−Š vKŽ ¡UIÐù« l� nBMK� C U¼e�d� ‰uŠ …dz«b�« U½dG� «–≈ ¨Èdš√ WNł s�

  ÆsOLO�« vKŽ Y�U¦�« qJA�« vKŽ qB×M� WIÐU��« W�U×�«
Command: Scale  (Sc )

Select objects: Specify opposite corner: 1 found              …dz«b�« dIM½ 
Select objects:          d�UMF�« —UO²š« ¡UN½ù ‰Ušœù« ÕU²H� jGC½
Specify base point:            C …dz«b�« e�d� w¼Ë ”UÝ√ WDI½ œb×½  
Specify scale factor or [Reference]: 0.5 
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±∞¥

 Trim V¹cA²�«

 dBMŽ Trim ¢V¹cAð¢ d�_« cOHM²� d�u²¹ Ê√ V−¹ p�c� ÆtF� wI²K¹ dš¬ dBMŽ s� bz«e�« dBMF�« W�«“≈ u¼
 œU�uðË√ pM� VKD¹ ¢V¹cAð¢ d�_ „cOHMð ‰UŠ ÆCutting Edge lÞUI�UÐ ÁuŽbMÝË wK�_« dBMF�« w�ö¹ dš¬

∫wðü« ‰U¦L�« w� UL� bz«e�« dBMF�« b¹b×ð rŁ s�Ë lÞUI�« b¹b×ð

∫‰U¦�

     Æ…dz«b�« œËbŠ qš«œ ÍËUL��« ‚—“_« j��« lD�«

 
 ©≥∏® qJý

Command: Trim  (Tr )

Current settings: Projection=UCS, Edge=Extend

Select cutting edges                WFÞUI�« ·«u×�« œ ÒbŠ 
Select objects: 1 found          …dz«b�« d²š« 
Select objects:              d�UMF�« —UO²š« ¡UN½ù ‰Ušœù« ÕU²H� jGC½
Select object to trim or shift-select to extend or [Project/Edge/Undo]:  

 …dz«b�« qš«œ ‚—“_« j��« ¡eł dIM½
Select object to trim or shift-select to extend or [Project/Edge/Undo]: 

 Æ…dz«b�« qš«œ s� j��« lD� r²O�

 Extend ¢œ«b²�«¢ d�_«

 ÆBoundary Edges œËb×�UÐ ÁuŽbMÝ dš¬ dBMŽ l� wI²KO� ÂuÝd� dBMF� œ«b²�« qLŽ vKŽ d�_« «c¼ ÂuI¹
 w²�« d�UMF�« b¹b×ð pM� VKD¹ rŁ œËb×�« Ác¼ b¹b×ð œU�uðË√ pM� VKD¹ ¢œ«b²�«¢ d�_ „cOHMð ‰UŠ ¨p�c�

∫wðü« ‰U¦L�« w� UL� U¼bL²Ý
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±∞μ

∫‰U¦�

ÆdLŠ_« ÊuK�UÐ sOD��UÐ WK¦LL�« œËb×�« v�≈ ÍËUL��« ‚—“_« ÊuK�UÐ Ídz«b�« ”uI�«Ë j��« b�

q³� bFÐ

©≥π® qJý
 

Command: Extend  : (Ex )

Current settings: Projection=UCS, Edge=Extend

Select boundary edges ...

   dýRL�UÐ dLŠ_« ÊuK�UÐ sOD��« dIMÐ VO−²�²� œ«b²�ô« œËbŠ b¹b×ð œU�uðË√ VKD¹
Select objects: 1 found

Select objects: 1 found, 2 total

Select objects: 

 p�c�Ë ¨ÁbLÐ Vždð Íc�« dBMF�« —UO²šUÐ œU�uðË√ VO−²�O� œËb×�« —UO²š« ¡UN½ù ‰Ušœù« ÕU²H� jGC½
  ÆÎ«bŠ«Ë Î«bŠ«Ë ÍËUL��« ‚—“_« ÊuK�UÐ j��«Ë ”uI�« ·«dÞ√ dIM½

Select object to extend or shift-select to trim or [Project/Edge/Undo]:    ÍuKF�« j��« ·dÞ dI½√ 
Select object to extend or shift-select to trim or [Project/Edge/Undo]:   ÍuKF�« ”uI�« ·dÞ dI½√
Select object to extend or shift-select to trim or [Project/Edge/Undo]:    wKH��« j��« ·dÞ dI½√ 
Select object to extend or shift-select to trim or [Project/Edge/Undo]:   wKH��« ”uI�« ·dÞ dI½√ 
Select object to extend or shift-select to trim or [Project/Edge/Undo]:       ¡UN²½ö�

 ÆÁöŽ√ qJA�« w� UL� WÐuKDL�«  «œ«b²�ô« vKŽ qB×M�
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±∞∂

 Chamfer ¢nDý¢ d�_«

 Ë√ sOMzU� d�uð V−¹ ¨p�c�Ë ÆszUJ�« w� Èdš√ ·«uŠ ¡UMÐË U¹«Ëe�«Ë ·«u×�« lD� vKŽ d�_« «c¼ ÂuI¹
 b¹b×ð œU�uðË√ pM� VKD¹ ¢nDý¢ d�√ cOHM²Ð ¡b³�« ‰UŠ ÆULNOKŽ Chamfer ¢nDý¢ d�_« cOHM²� s¹dBMŽ

 ∫wðü« ‰U¦L�« ÷dF²�M� ÆUL¼dI½ rŁ s�Ë W�uDA� W�U×Ð ULNDÐ— »uKDL�« sOFKC�« vKŽ WŽuDIL�« rOI�«

∫©±® ‰U¦�

  Æ©¥∞® qJA�« vKŽ√ w� Line d�_UÐ ◊uD�� ÂuÝdL�« qOD²�LK�  ·«u×�« nDý√
Command: Chamfer 

(TRIM mode) Current chamfer Dist1 = 0, Dist2 = 0

Select first line or [Polyline/Distance/Angle/Trim/Method]: D nDA�«  U�U�� D —UO²šô« V²J½ 
Specify first chamfer distance <0>: 5         v�Ë_« W�U�L�« œb×½
Specify second chamfer distance <5>: 3           WO½U¦�« W�U�L�« œb×½
Select first line or [Polyline/Distance/Angle/Trim/Method]:    wI�_«Ø‰Ë_« lKC�« dIM½ 
Select second line:        wÝ√d�«Øw½U¦�« lKC�« dIM½

 ÆjI� …bŠ«Ë W¹Ë«“ t� XHDý b�Ë qOD²�L�« vKŽ qB×M�

 ∫©≤® ‰U¦�

 Æ©¥∞® qJA�« qHÝ_« w� Polylines ◊uDš œbF²L� ÂuÝdL�« qOD²�LK� ·«u×�« nDý√
  UODFL�« UM¼ dOG²ð

Command: Chamfer 

(TRIM mode) Current chamfer Dist1 = 5, Dist2 = 3

Select first line or [Polyline/Distance/Angle/Trim/Method]: D  nDA�«  U�U�� D —UO²šô« V²J½ 
Specify first chamfer distance <5>: 5        v�Ë_« W�U�L�« œb×½
Specify second chamfer distance <5>: 3          WO½U¦�« W�U�L�« œb×½
Select first line or [Polyline/Distance/Angle/Trim/Method]: P        ◊uD��« œbF²� —UO��« œb×½ 
Select 2D polyline:              »uKDL�« ◊uD��« bF²� dIM½ 
4 lines were chamfered
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±∞∑

bFÐq³�

©¥∞® qJý

 ÆÁU¹«Ë“ lOLł XHDý b�Ë qOD²�L�« vKŽ qB×M�

 Fillet ¢W�UŠ d¹Ëbð¢ d�_«

 s¹dBMŽ Ë√ sOMzU� d�uð V−¹ ÎUC¹√ UM¼Ë ÆU¹«ËeK� W¹dz«œ ·«uŠ qLŽ vKŽ Fillet ¢W�UŠ d¹Ëbð¢ d�_« ÂuI¹
 ”uI�« dD� nB½ b¹b×ð œU�uðË√ pM� VKD¹ Fillet ¢W�UŠ d¹Ëbð¢ d�_« cOHM²Ð ¡b³�« ‰UŠ ÆœU�uðË√ w� ÁcOHM²�

 ∫wðü« ‰U¦L�« ÷dF²�M� ÆULNO�H½ sO²�U×�« b¹b×ð pM� VKD¹ rŁ w½«—Ëb�« s�d�« «c¼ qLF� »uKDL�«

 ∫©±® ‰U¦�

 Æ©¥±® qJA�« vKŽ√ w� Line d�_UÐ ◊uD�� ÂuÝdL�« wÝ«b��« qJA�« ·«u×� Î«d¹Ëbð qLŽ√ 
Command: Fillet 

Current settings: Mode = TRIM, Radius = 100

Select first object or [Polyline/Radius/Trim]: r     …—ËbL�« W�U×�« dD� nB½  R —UO²šô« V²J½ 
Specify fillet radius <100>: 10                dDI�« nB½ —«bI� œb×½
Select first object or [Polyline/Radius/Trim]:               v�Ë_« W�U×�« dIM½
Select first object or [Polyline/Radius/Trim]:               WO½U¦�« W�U×�« dIM½
Select second object: 
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±∞∏

q³� bFÐ

©¥±® qJý

 ∫©≤® ‰U¦�

 Æ©¥±® qJA�« qHÝ√ Polygon d�_UÐ ◊uDš œbF²L� ÂuÝdL�« rE²ML�« ”b�L�« ·«u×� Î«d¹Ëbð qLŽ√
Command: Fillet 

Current settings: Mode = TRIM, Radius = 10

Select first object or [Polyline/Radius/Trim]: r      …—ËbL�« W�U×�« dD� nB½  R —UO²šô« V²J½ 
Specify fillet radius <10>:           dDI�« nB½ —«bI� œb×½
Select first object or [Polyline/Radius/Trim]: P  Polyline        ◊uDš œbF²�   P  V²J½ 
Select 2D polyline: Select 2D polyline:     ”b�L�« w� W�UŠ W¹√ dIM½
6 lines were filleted
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±∞π

  Array ¢W�uHB�¢ d�_«

 w� a�M�« Vðd²ð YO×Ð a�½ …bŽ v�≈ dBMF�« a�½ vKŽ d�_« «c¼ ÂuI¹ ÆœU�uðË√ w� …—uNAL�« d�«Ë_« bŠ√
 —U�O�« vKŽ wÝ√d�« j�K� WLE²M� ¢WO³D� W�uHB�¢ UMKLŽ wðü« qJA�« w� Æw³D� jL½ sL{ Ë√ …bLŽ√Ë ·uH�
 s� W½uJ� WLE²M� W�uHB� UMKLŽ rŁ ÆWł—œ ≥∂∞ W¹Ë«e�« sL{ d�UMŽ W�Lš s� W½uJ�Ë C WDIM�« s� ÎU�öD½«
 ÆrK� ≥∞tOK¹ Íc�«Ë œuLŽ q� sOÐ W�U�L�« ÊuJð YO×Ð WO³DI�« W�uHBL�« ŸuL−LK� …bLŽ√ WFÐ—√Ë bŠ«Ë Ìn�

©¥≤® qJý

 —«u×�« lÐd� sL{ WÐuKDL�«  U½UO³�« ‰Ušœ≈ ‰öš s� r²¹ œU�uðË√ w� d�_« «c¼ cOHMð Ê√ d�c�UÐd¹b−�« s�
 ÆOk WI�«uL�« —“ vKŽ jGC�« rŁ Array
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±±∞

 UMzUJ�« hzUBš  «Ëœ√ j¹dý ∫”œU��« ”—b�«
 VOðd²�UÐ w¼Ë hzUB��« s� WŽuL−� vKŽ Íu²×¹ ¨UN�uDÐË WýUA�« s� ÍuKF�« ¡e−�« w� j¹dA�« «c¼ ÊuJ¹

 ∫sOLO�« v�≈ —U�O�« s�

j��« Ÿu½ j��« pLÝj��« Êu� UI³D�«

©¥≥® qJý

 Layers  UI³D�«

 UNM�  …b??Š«Ë  q�  eOL²ð  YO×Ð  WHK²��   UI³Þ  ¡UMÐ  UN�öš  s�  sJL¹  j¹dA�«  s�  —U�O�«  vB�√  w�  błuð
ÆWI³D�« Ác¼ sL{ W�uÝdL�«  UMzUJ�«Ë ◊uD��« pLÝË ŸuM�« ¨ÊuK�« VKž_« vKŽ qLA²� WMOF�  UH�«uLÐ

Color j)« Êu�

 ÆÂb�²�L�« j��« Êu� b¹b×ð r²¹ ¡e−�« «c¼ w�Ë

©¥¥® qJý
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±±±

    Linetype  j)« Ÿu½

 ‰ušb�« rŁ Other ¢p�– dOž¢ vKŽ jGC�« Ë√ W�b�M� WLzU� s� Á—UO²šUÐ Âb�²�L�« j��« Ÿu½ b¹b×ð r²¹ tO�Ë
 Æ»uKDL�« j��« Load ¢qOL×ð¢ „UM¼ r²O� Linetype maneger ¢ UI³D�« d¹b�¢ —«u×�« ‚ËbM� v�≈

Lineweight j)« pLÝ

 ÆW�b�ML�« t²LzU� s� »uKDL�« j��« W�ULÝ —UO²š« r²¹ tO�Ë

 ∫WEŠö�

 ÆtŽu½Ë tJLÝË t½uKÐ jš q� eOLM� ¨œb×� jš vKŽ WI³Þ q� Íu²×ð YO×Ð  UI³D�« ÂUE½ Â«b�²Ý« qCH¹
 UN�«b�²Ý« bMŽ wDFð ≤ WI³D�« ÆwzdL�« j��« q¦LO� ÎUJOLÝË ÎöB²� ÎUDš UN�«b�²Ý« bMŽ wDFð ± WI³D�« ¨‰U¦L�Ë
 wH�L�« j��« q¦LO� ÎUDÝËË ÎUFDI²� ÎUDš UN�«b�²Ý« bMŽ wDFð ≥ WI³D�« ÆÍe�dL�« j��« q¦LO� ÎUFO�—Ë ÎUFDI²� ÎUDš

 Æ«cJ¼Ë ÆÆÆ wzUA½ù« j��« q¦LO� ÎUFO�—Ë ÎöB²� ÎUDš UN�«b�²Ý« bMŽ wDFð ¥ WI³D�« ÆpL��« WOŠU½ s�

 ∫ÂU¼ tO³Mð

 vKŽ ÃËœeL�« dIM�UÐ sOF� ÌszU� hzUBš q¹bFð sJL¹
 Properties  ¢hzUBš¢  —«u×�«  lÐd�  dNEO�  t�H½  szUJ�«
 dIM�U� ¨«cJ¼Ë ÆWÐuKDL�« hzUB��«Ë  UH�«uL�« dOOGð r²O�
 XLÝ— UN½√ s³¹ rÝd�« WýUý vKŽ W�uÝd� …dz«b� ÃËœeL�«
 μ∞ U¼dD� nB½Ë 200,100 WDIM�« w� U¼e�d� ÊuJ¹ YO×Ð
 ¨UNO� W�uÝdL�« WI³D�« ¨UNDO×� ¨UN²ŠU�� sO³¹ UL� ¨rK�

 Æ©¥μ® qJA�« dE½√ ¨ÆÆÆ j��« pLÝ ¨UN½u�

 Properties hzUB��« ¢—«u×�« lÐd�¢ ∫©¥μ® qJý
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±±≤

s¹bF³Ð rÝ— W�—Ë vKŽ Íd²�Ëe¹_« rÝd�« ∫lÐU��« ”—b�«
 qOFHð ¨W¹d²�Ëe¹√ Ì U�uÝ— ÃU²½ô ‚dD�« qNÝ√ s�
 r²¹ Íc�«Ë ¨Isometric Snap Íd²�Ëe¹_« VŁu�« jL½

Æ‚dÞ …bFÐ tOKŽ ‰uB×�«

 WŁö¦�« W¹d²�Ëe¹_«  U¹u²�L�«Ë —ËU×L�« ∫©¥∂® qJý

 Ë√ ¨d�«Ë_« …c�U½ w� dsettings WÐU²JÐ  ±
 rŁ WOÝUOI�« WLzUI�« s� Tools ¢ «Ëœ√¢ —UO²šUÐ  ≤

¢rÝd�«  «œ«bŽ≈¢ —UO²š«
Tools>Drafting Settings   

 VKž√  W��ö�  bMŽ  dýRLK�  5LO�«  —e??�«  dI½  ≥
  «œ«bŽ≈¢ dI½ rŁ qHÝ_« w� W�U(« j¹dý —«—“√

ÆSettings ¢rÝd�«
Æ©¥∑® qJA�« w� Drafting Settings ¢rÝd�«  «œ«bŽ≈¢ —«u×�« lÐd� dNE¹ WIÐU��«  ôU×�« lOLł w�

 sL¹_« eO×�« w� Snap type & style ¢VŁu�«  jL½¢ rŁ Snap and Grid ¢WJ³A�«Ë VŁu�«¢ ÊU�K�« —U²�½
 —“ jGC½ rŁ Isometric snap ¢Íd²�Ëe¹√ jL½¢ UNKHÝ√Ë Grid snap ¢WJ³A�« jL½¢ „UM¼ œb×M� ¨wKH��«Ë

  ÆqHÝ_« w� Ok WI�«uL�«

Íd²�Ëe¹√ jL½

Drafting Settings  ¢rÝd�«  «œ«bŽ≈¢ —«u×�« lÐd� ∫©¥∑® qJý

. https://www.wepal.net
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±±≥

 d�«Ë_« …c�U½ w� Snap d�_« WÐU²JÐ Isometric snap Íd²�Ëe¹_« VŁu�« jL½ vKŽ ‰uB×�« sJL¹ UL�
Command: snap

Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.000>: S

©Style —UB²š«® S V²J½
Enter snap grid style [Standard/Isometric] <S>: I   

©Isometric —UB²š«® I V²J½
Specify vertical spacing <10.000>: 

 d�_« WÐU²� Ë√ ¨Drafting Settings ¢rÝd�«  «œ«bŽ≈¢ —«u×�« lÐd� Â«b�²Ý« ¡«uÝ sO²IÐU��« sO²�U×�« w�Ë
∫WO�U²�«  UOF{u�« ÈbŠ≈ v�≈ ‰u×ð b� dýRL�« Ê√ b−½  d�«Ë_« …c�U½ w� Snap

                        
Íd²�Ëe¹_« rÝd�« w� dýRL�« ‰UJý√  ∫©¥∏® qJý

 bMŽË ÆsOFL²−� Ctrl+E  sOŠU²HL�«  jGC½ Ë√   F5  ÕU²HL�«  jGC½ dýRLK�  Èdš√Ë WOF{Ë sOÐ  qIM²K�Ë
 Ortho ¢b�UF²�¢ —UO��« Â«b�²ÝUÐ —uEMLK� …b�UF²L�« ÕuD��« ·«uŠ rÝdð Íd²�Ëe¹_« VŁu�« jL½ w� qLF�«
 ¨p�c�Ë ¨ÎUIÐUÝ  œ—Ë w²�« …dýU³L�« WI¹dD�UÐ ◊uD��« rÝ— r²¹ U¼bMŽË ¨Status bar ¢W�U×�« j¹dý¢ s�
 WOF{Ë Â«b�²ÝUÐ WO�U�_« ÕuD��« rÝdðË ¨sOLO�« vKŽ dýRL�« WOF{Ë Â«b�²ÝUÐ W¹uKF�« ÕuD��« ·«uŠ rÝdð

Æ©¥∏® qJý ¨—U�O�« vKŽ dýRL�« WOF{Ë Â«b�²ÝUÐ WO³½U−�« ÕuD��« rÝdðË UL� ¨jÝu�« w� dýRL�«

∫©±® ‰U¦�

 ÆÎ«d²LOKO� 15x20x30 ÁœUFÐ√ Íc�«  öOD²�L�« Í“«u²� rÝ—«

©¥π® qJý
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±±¥

 Ortho on b�UF²�« jL½ q =F ÓHÔ½
Æ1 WDIM�« sJ²�Ë dýRL�UÐ ‚öD½ù« WDI½ œb×M� ¢jš¢ d�_« Âb�²�½

 1 2 3 4  ULOI²�L�UÐ WK¦LL�«Ë  öOD²�L�« Í“«u²L� ÍuKF�« `D��« ·«uŠ rÝd�
 Y×L�« rIK½ rŁ ¨©2 WDIM�« ÁU−ðUÐ® sOLOK� dýRL�« „d×M� Isoplane Top WOF{u� qB½ v²Š F5 ÕU²HL�« jGC½

 Æ©μ∞® qJý ¨2 WDIM�« ZM²²� ¨≥∞ WLOI�UÐ

©μ∞® qJý

Æ3 WDIM�« ZM²²� ≤∞ rIK½Ë UNMOL¹ v�≈Ë 2 WDIM�« ÂU�√ dýRL�« l{u� dOG½

©μ±® qJý

 vKŽ qB×M� rÝd�« oKG½ rŁ Æ4 WDIM�« ZM²²� ¨≥∞ rIK½Ë U¼—U�¹ v�≈Ë 3 WDIM�« ÂU�√ dýRL�« l{u� dOG½ rŁ
  Æ öOD²�L�« Í“«u²L� ÍuKF�« `D��«
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±±μ

  ©μ≤® qJý

 Isoplane Right WOF{u� qB½ v²Š F5 ÕU²HL�« jGC½ 3 4 6 5 w�U�_« `D��« ·«uŠ rÝd�
 Æ5 WDIM�« vKŽ qB×M� rK� ±μ W�U�LÐË qHÝú�Ë 3 WDIM�« s� ÎU�öD½« wÝ√d�« j��« rÝd½

 Æ6 WDIM�« vKŽ qB×M� ≥∞ rIK½Ë qHÝ_«Ë —U�OK� dýRL�« l{u� dOG½
Æ©μ≥® qJý ¨ 4 WDIM�« v�≈ qBM� ±μ rIK½Ë 6 s� ÎUDš rÝdM� vKŽú� dýRL�« l{Ë dOG½

©μ≥® qJý

Isoplane Left WOF{u� qB½ v²Š F5 ÕU²HL�« jGC½ 1 4 6 7 w³½U−�« `D��« ·«uŠ rÝd�
  Æ1 WDIMK� qB²� rK� ±μ —«bIL�UÐ vKŽú� dýRL�« l{u� dOž rŁ rK� ≤∞ —«bIL�UÐ ÎUDš —U�OK�Ë 6 WDIM�« s� rÝ—«

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



±±∂

Isometric circles Íd²�Ëe¹_« …dz«b�« —uEM� rÝ—

 rŁ  Isocircle ¢…dz«b�« —uEM�¢ —UO²š« rŁ Ellipse ¢h�U½ lD�¢ d�√ Â«b�²ÝUÐ W¹d²�Ëe¹_« dz«Ëb�« rÝdð
ÆW¹d²�Ëe¹_« …dz«b�« dD� nB½ —«bI� Y×L�« w� rIK½

∫©≤® ‰U¦�

10,30 WDIM�« U¼e�d�Ë μ∞ U¼dD� nB½ w²�« ÍuKF�« `D��« w� Íd²�Ëe¹_« …dz«b�« —uEM� rÝ—«
Command: El 

ELLIPSE

Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: I 

Specify center of isocircle: 10,30 

Specify radius of isocircle or [Diameter]: <Isoplane Left> <Isoplane Top> 50 

  Isoplane Top  ÍuKF�« `D��« WOF{Ë v�≈ UMK�Ë v²Š F5 ÕU²HL�« UMDG{ dDI�« nB½ —«bI� rOIKð qO³�Ë UM½√ kŠö½

©μ¥® qJý
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±±∑

∫©≥® ‰U¦�

 Æ©μμ® qJý ¨V�dL�« —uEML�« rÝ—«

©μμ® qJý

 Isopalne Top  Ê√ s� b�Q²½Ë  Ortho on b�UF²�« jL½ q =F ÓHÔ½
Æ«cJ¼ UNO�≈ Î«œuŽË A WDIM�« s� ÎU�öD½« ©WŽU��« »—UIŽ l�® ABCDE ÍuKF�« `D��« ·«uŠ ÎôË√ rÝd½

Command: L 

LINE Specify first point:             A WDIM�« œbŠ 
Specify next point or [Undo]: 40         40  V²�√ rŁ A s� —U�OK� dýRL�« ‰uŠ
Specify next point or [Undo]: 100        ∫sO³�u¼ UL� lÐUð rŁ
Specify next point or [Close/Undo]: 80 

Specify next point or [Close/Undo]: 70 

Specify next point or [Close/Undo]: C 

Æ©μ∂® qJA�« vKŽ qB×M�

 ©μ∂® qJý
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±±∏

 ◊uD��« bŠ√ rÝ— sJL¹® ÆrK� ≤∞ —«bILÐË qHÝú� B Ë D ¨ E¨ A ◊UIM�« s� WOÝ√— ◊uDš WFÐ—√ rÝd½
  Æ(Copy a�M�« d�√ Â«b�²Ý« rŁ s�Ë

©μ∑® qJý

Æ©μ∏® qJý ¨◊uD�Ð ◊uD��« Ác¼ ·«dÞ√ q�u½ rŁ

©μ∏® qJý
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±±π

 sOFÞUI²L�« sO¹e�dL�« sOD��« rÝdÐ p�–Ë A B C D E `D��« vKŽ W¹dz«b�« W½«uDÝ_« …bŽU� —uEM� e�d� œb×½
ÆW½«uDÝô« …bŽU� —uEM� rÝd½ ¨tOKŽ

Command: Ellipse 

Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: I 

Specify center of isocircle:           ÍuKF�« `D��« w� sO¹e�dL�« sOD��« lÞUIð dIM½
Specify radius of isocircle or [Diameter]:  <Isoplane Top> 25        dDI�« nB½ ≤μ V²J½

©μπ® qJý

 Æ…dz«b�« Í—uEML� sOÝUL� sODš rÝd½Ë ¨Copy d�ô« Â«b�²ÝUÐ rK� ≤∞ W�U�� vKŽú� …dz«b�« —uEM� a�M½

©∂∞® qJý
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±≤∞

 Æ©∂±® qJA�« w� »uKDL�« —uEML�« vKŽ qB×M� rÝd�« w� bz«Ëe�« V¹cA²� Trim d�ô« Âb�²�½

©∂±® qJý

 WEŠö�

 ‚dD�« s� ÌÍQÐ Rectangle snap wI�_« Èu²�L�« sL{ ÍœUF�« rÝd�« jL½ v�≈ WE×� W¹√ w� Ÿułd�« sJL¹
 Æ”—b�« W¹«bÐ w� WŠËdAL�« WŁö¦�«

 Æd�«Ë_« …c�U½ w� dsettings WÐU²JÐ  ±
Tools>Drafting Settings ¢rÝd�«  «œ«bŽ≈¢ —UO²š« rŁ WOÝUOI�« WLzUI�« s� Tools ¢ «Ëœ√¢ —UO²šUÐ  ≤
ÆSettings ¢rÝd�«  «œ«bŽ≈¢ dI½ rŁ qHÝ_« w� W�U(« j¹dý —«—“√ VKž√ W��ö� bMŽ dýRLK� 5LO�« —e�« dI½  ≥

 Drafting Settings ¢rÝd�«  «œ«bŽ≈¢ —«u×�« lÐd� dNE¹ WIÐU��«  ôU×�« lOLł w�
 ¨wKH��«Ë sL¹_« eO×�« w� Snap type & style¢VŁu�«  jL½¢ rŁ Snap and Grid¢WJ³A�«Ë VŁu�«¢ ÊU�K�« —U²�½
  ÆqHÝ_« w� WI�«uL�« —“ jGC½ rŁ Rectangle snap¢ÍœUŽ jL½¢ UNKHÝ√Ë Grid snap¢WJ³A�« jL½¢ „UM¼ œb×M�

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



±≤±

 ÆœU�uð_« Z�U½dÐ Â«b�²ÝUÐ WOðü« ‰UJý_« rÝ—« ∫ s¹—ULð
 ©±® s¹d9

 ©≤® s¹d9
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±≤≤

 ©≥® s¹d9

 ©¥® s¹d9
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±≤≥

 ©μ® s¹d9

 ©∂® s¹d9
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±≤¥

 ©∑® s¹d9

 ©∏® s¹d9
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±≤μ

                              Solid Modeling  UL�−L�« rÝ— ∫s�U¦�« ”—b�«

©Boolean  Operation® tOIDML�« d�«Ëô«Ë  solid d�«Ë« tDÝ«uÐ œUFÐô« tOŁöŁ ÂuÝ— ¡UA½« ∫»uKDL�«

∫·«b¼_«
ÆtI¹dÞ q� tO½UJ�«Ë œUFÐô« wŁöŁ rÝd�« ‚dÞ œbFð  ≠±
ÆSolids d�«Ë« tDÝ«uÐ ÁbIF�Ë tDO�Ð U�uÝ— TAMð  ≠≤

ÆtOIDML�«  UOKLF�« tDÝ«uÐ  t�bI²� U�uÝ— TAMð ≠≥
ÆrN�ULF²Ý« r²¹ v²� œb×ðË W�UL��« d�Ë«Ë o¦³�« d�« tDÝ«uÐ U�uÝ— TAMð ≠¥

Æ`O×� fJF�«Ë œUFÐ_« WOŁöŁ ÂuÝ— v�« bF³�« tOzUMŁ ÂuÝd�« ‰u×ð ≠μ

 s�  ŸuM�«  «c¼  Â“ö??¹  Íc??�«  ‰UO��«  V³�Ð  p??�–Ë  ÁdO¦L�«Ë  tIOA�«  lO{«uL�«  s�  d³²F¹  œUFÐô«  wŁöŁ  rÝ—
 nB²¹ Ê« V−¹ qÐ öNÝ öLŽ ‰«uŠô« q� vKŽ fO� œUFÐô« wŁöŁ v�« œUFÐô« wzUMŁ rÝ— q¹u×²� ¨ U�uÝd�«
 ÁœUH²Ýô« «bŽ Ã–ULM�« Ë«  U�uÝd�«  sOÐ jÐd�« vKŽ Á—bI�«Ë ‰UO��« tF�Ð œUFÐ_« WOŁöŁ  U�uÝd�« qLFÐ ÂuI¹ s�

Æ  U�uÝd�« ÃU²½« w� Auto CAD  «Ëœ« nOþuð s�
 q¹bF²�«Ë  `�L�« ¡«dł«Ë ©a�«ÆÆÆÆÆÆ ÁdJ�«Ë ◊Ëd�L�«Ë VFJL�«® q¦� tOÝUÝô« d�UMF�« sOÐ jÐd�« Ê«

∫w¼Ë rÝdK� ‚dÞ ÁbŽ błu¹Ë¨œUFÐ_« WOŁöŁ  U�uÝ— Z²M¹ UNOKŽ
Solid  «Ëœ« tDÝ«uÐ t²LB� œUFÐ_« WOŁöŁ ÂuÝ— ¡UA½« ≠±

Extrude tDÝuÐ WOŁöŁ v�« bF³�« tOzUMŁ ÂuÝd�« q¹u×²Ð œUFÐ_« WOŁöŁ ÂuÝ— ¡UA½«– ≤
ÆThickness d�ô« tDÝ«uÐ œUFÐ_« WOŁöŁ ÂuÝ— ¡UA½«≠≥

ÆbF³�« tOzUMŁ  U�uÝd�« sOÐ jÐd�«Ë« qO�u²�UÐ p�–Ë œUFÐ_« WOŁöŁ ÂuÝ— ¡UA½«≠¥
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±≤∂

Solids  t²LB*« ÂU�łô« rÝ—

©∂≤® qJA�« w� Ëb³¹ UL� t²LBL�« ÂU�łô« rÝd� qI²��  «Ëœ« j¹dý dO�u²Ð  Auto CAD ÂuI¹

©∂≤® qJý

œUFÐô« wŁöŁ rÝd�« v�« rÝd�« týUý q¹u×ð
∫ w�U²�U� œUFÐô« wŁöŁ týUý v�« rÝd�« týUý ‰u×ð Ê« qCH¹ œUFÐô« wŁöŁ rÝd�UÐ √b³½ Ê« q³�

t�b�M� tLzU� Ëb³ð ·uÝ XÐU¦�«  «Ëœô« j¹dý w� View vKŽ dI½« ≠±
Æ t�b�M� tLzU� Ëb³ð ·uÝ 3D Views d²š«≠≤

Æ ©∂≥® qJA�« w� UL�  UOŁ«bŠô« ÂUE½ ‰u×²¹ ·uÝ SE Isometric d²š« ≠≥

œUFÐô« wŁöŁ v�« q¹u×²�« bFÐ ucs                œUFÐô« wŁöŁ v�« q¹u×²�« q³� ucs
©∂≥® qJý

 w� ©UCS® qJý ÊuJ¹ Ê« qCH¹ bF³�« wŁöŁ rÝd�« v�« bF³�« wzUMŁ rÝd�« s�  UOŁ«bŠô« X�uŠ Ê« bFÐ
∫tO�U²�«  «uD��« ŸU³ðUÐ p�–Ë wJK��« l{u�«

Æ t�b�M� tLzU� Ëb³ð ·uÝ XÐU¦�«  «Ëœô« j¹dý w� View jA½≠±
Æ t�b�M� tLzU� Ëb³ð ·uÝShade d²š«≠≤

Æ©∂¥® qJA�« w� UL�  UOŁ«bŠô« ÂUE½ ‰u×²¹ ·uÝ 3D Wireframe d²š«≠≥
©∂¥® qJý
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±≤∑

  BOX  VFJ� rÝ—

VFJLK� v�Ëô« ©s�d�«® tDIM�« UNMŽ œbŠ ÁU½œ« t�UÝd�« Ëb³ð ·uÝ d�ô« jA½ ≠±
Specify corner of box or[Center] <0,0,0> :0,0  

∫tO�U²�« t�UÝd�« ÂU�« VFJL�« s�d� tO½U¦�« tDIM�« qšœ« ≠≤
Specify  corner or[Cube length]: 100,60  

∫t�UÝd�« ÂU�« VFJL�« ŸUHð—« qšœ« ≠≥
Specify height ∫ 40  

Æ©∂μ®  qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ
©∂μ® qJý

 Sphere  t²LB� Ád� rÝ—

sphere d�ô« jA½ ≠±
∫ tO�U²�« t�UÝd�« ÂU�« ©∞¨∞® ÁdJ�«e�d� qšœ« ≠≤

Specify center of sphere <0,0,0> :0,0  

∫tO�U²²�« t�UÝd�« ÂU�« ©≥μ® ÁdJ�« dD� nB½ qšœ« ≠≥
Specify radius of sphere or ›Diameter¤  ∫ 35  

©∂∂®qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ
©∂∂® qJý

∫tO�U²�« «uD��« ŸU³ðUÐ p�–Ë ©∂∑®  qJA�« w� UL� Ëb³ð ·uÝ ¨ÁdJ�« qKþ ≠¥
   View     Shade     Shade Gouraud 

                                        jI� rŽU½ qJAÐ …dJ�« qOKEð

©∂∑® qJý

. https://www.wepal.net
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±≤∏

              Cylinder  t½«uDÝ« rÝ—
Cylinder d�ô« jA½≠±

∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©∞¨∞®  t½«uDÝô« e�d� qšœ«≠≤
  Specify center point for base of cylinder or [Elliptical] <0,0,0>: 0,0    

∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©≥μ® t½«uDÝô« dD� nB½ qšœ« – ≥
 Specify radius for base of cylinder or [Diameter]: 35  

∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ  ©μ∞® t½«uDÝô« ŸUHð—« qšœ« – ¥
  Specify height of cylinder or ›Center or end ¤ ∫ 50  

    ©∂∏® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ – μ
©∂∏® qJý

 p�–Ë  ©∂π®  qJA�«  w�  UL�  Ëb³ð  ·uÝ  ¨t½«uDÝô«  qKþ  – ∂
∫ tO�U²�«  «uD��« ŸU³ðUÐ

   View     Shade     Shaded Flat

w×DÝ qJAÐ t½«uDÝô« qOKEð©∂π® qJý

Cone  ◊Ëd�*« rÝ—

Cone  d�ô« jA½ ≠±
∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ   ©∞¨∞® ◊Ëd�L�« e�d� qšœ« ≠≤

Specify center point for base of cone or [Elliptical] <0,0> : 0,0  

∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ©≥∞® ◊Ëd�L�« dD� nB½ qšœ« ≠≥
Specify radius for base of Cone or [Diameter] : 30  

∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©∂μ® ◊Ëd�L�« ŸUHð—« qšœ« ≠¥
Specify height of cone or [Apex] : 65  

                  ©∑∞® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ – μ
©∑∞® qJý

∫tO�U²�«  «uD��« ŸU³ðUÐ p�–Ë ©∑±® qJA�« w�UL� Ëb³¹ ·uÝ ◊Ëd�L�« qKþ ≠∂
View     Shade     Shaded Flat ,Edges on  

·«u×�« —UNþ« l� w×DÝ qJAÐ ◊Ëd�L�« qOKEð    ©∑±® qJý

. https://www.wepal.net
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±≤π

Torus  t²LB*« tIK(« rÝ—

Torus   d�ô« jA½ ≠±
∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©∞¨∞¨∞®  Torus  e�d� qšœ« ≠≤

Specify center of torus <0,0,0> :  0,0,0  

∫t�UÝd�« Ëb³ð U�bMŽ ©∂∞® sJO�Ë Torus dD� nB½ qšœ« ≠≥
Specify radius of torus or ›Diameter¤ ∫ 60  

 Ëb³ð U�bMŽ ©±∞® sJO�Ë sJO�Ë t²LBL�« tIK×�« dD� nB½ qšœ«  ≠¥
∫ tO�U²�« t�UÝd�«

Specify radius of tube or ›Diameter¤ ∫ 10  
©∑≤® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ ≠μ©∑≤® qJý

 ŸU³ðUÐ  p�–Ë  ©∑≥®  qJA�«  w�  UL�  Ëb³¹  ·uÝ  tIK×�«  qKþ  ≠∂
∫ tO�U²�«  «uD��«

View     Shade      gouraud¨Edges on  
©∑≥® qJý                       

 WEŠö�

∫ w�U²�U� w¼Ë ‚dÞ lÐ—« ©Shade® ¡U�J�« Ë« ÍœUF�« qOKE²�«  ‚dÞ –  A
©∂π® qJý w� UL�  ©Flat Shaded® w×D��« Ë« ÍœUF�« qOKE²�« ≠±  

©∂∑® qJý w� UL�Gouraud®  © Shaded rŽUM�« qOKE²�« ≠≤  
©∑±® qJý w� UL� ©Shaded Gouraud ̈ Edges on® ·«u×�« —UNþ« l� ÍœUF�« qOKE²�« ≠≥  

©∑≥® qJý w� UL�©Shaded Gouraud ̈ Edges on® ·«u×�« —UNþ« l� rŽUM�« qOKE²�«≠¥  
Æ Ád¹b²�L�« ‰UJýô« w� ô« rŽUM�«Ë w×D��« qOKE²�« sOÐ ‚dH�« `C²¹ ô ≠B

 ôË bOł Ã«dšô« ÊuJ¹ wJ� jI� Ád¹b²�L�« ‰UJý ô« vKŽ ô≈ ©Gouraud® rŽUM�« qOKE²�« o³D¹ ô  ≠C

Æ Áœ«bŽ« bMŽ ÁdO³� tŠU�� cšQ¹

. https://www.wepal.net
www.wepal.net | RESOURCE #100747 | TRACK 0865c41ff003e940



±≥∞

©Operations® tOIDM*«  UOKLF�«

 ‚dÞ s� tI¹dÞ d³²Fð wN� Æ U¼œdHLÐ ÁbIF� U�uÝ— Z²Mð ô¨ bF³�«  tOŁöŁ ‰UJýö� tOÝUÝô« d�UMF�«  Ê«
∫ tOIDML�«  UOKLF� « s�Ë tłcLM�«

 Á—u� vKŽ Áœułu� d�«Ëô« Ác¼Ë ¨©Intersect® lÞUI²�« Ë« ©Union® bOŠu²�« Ë« ©Subtract® ÕdD�«
Æ©∑μ® qJý Ë« ©∑¥® qJý w� UL� ©Solids Editing®  «Ëœ« j¹dý w�  U½uI¹«

©∑¥® qJý
                           

©∑μ® qJý

. https://www.wepal.net
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±≥±

Subtract  ÕdD�«d�«

 ÂU�łô« ÕdDÐ p�–Ë ©a�«ÆÆÆÆÆÆÆÆ »uI¦�«Ë VOÐU½ô«® q¦� U³�Už t�u−� ‰UJý« ÃU²½UÐ d�ô« «c¼ ÂuI¹
Æ t¹bOKIð dOž t²LB� ÂU�ł« ÃU²½« Ë« t²LBL�«

∫ d�ô« qLŽ tI¹dÞ

 Subtract d�« jA½ ≠±
©tM� ÕËdDL�«® dO³J�« dBMF�« d²š« ≠≤

Enter  jG{« ≠≥
Enter rŁ  ©Õ—UD�«® dBMF�« d²š« ≠¥©∑∂® qJý

 ©∑∂® w�U²�« qJA�« rÝ—«    ∫ ‰U¦�

∫ q×�«

Cylinder t½«uDÝ« rÝ— d�« jA½ ≠±
                                            ©∞¨∞® t½«uDÝô« e�d� qšœ«≠≤ 

≥∞  t½«uDÝô« dD� nB½ qšœ« ≠≥ 
μ∞  t½«uDÝô« ŸUHð—« qšœ« ≠¥

                                   ©∑∑® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ  ©∑∑® qJý

                Cylinder d�ô« jOAM²Ð p�–Ë tO½U¦�« t½«uDÝô« rÝ—« ≠μ
Æ ©∞¨∞® t½«uDÝô« e�d� qšœ« ≠∂
≤∞ t½«uDÝô« dD� nB½ qšœ« ≠∑

Æ ©∑∏® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ μμ tIÐU��« t½«uDÝô« ŸUHð—« s� d³�« sJO�Ë t½«uDÝô« ŸUHð—« qšœ« ≠∏

qOKE²�« q³� qJý                                ©∑∏® qJý                      qOKE²�« bFÐ qJA�«

. https://www.wepal.net
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±≥≤

Subtract    ÕdD�« d�«   ≠π
Æ tDIM�Ëb³ð ·uÝ ©¡«dC��« ® ÁdO³J�« t½«uDÝô« jA½ Ë« d²š«≠±∞

ÆtKB²� t½«uDÝô« ◊uDš œuFð ·uÝ sOL¹ Á—QH�« Ë« Enter jG{« ≠±±
ÆtDIM� Ëb³ð ·uÝ ©¡«dL×�«® ÁdOGB�« t½«uDÝô« jA½ ≠±≤

Æ ©∑π® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ ¨ Á—UH�« sOL¹ Ë« Enter  jG{«≠±≥

©∑π® qJý

Union    bOŠu²�« d�«

 ZðUM�« rÝd�« «c¼ l� q�UF²�« ÊU� w�U²�UÐË¨bŠ«Ë dBMŽ QN½U�Ë bF³�« tOŁöŁ d�UMŽ ÁbŽ qFł u¼ bOŠu²�« d�«
 ÂuÝd�« bO�uðË ÁœUF²Ý« w� bŽU�¹ UL� rÝd�« nK� r−Š qKI¹Ë¨Ábze�« ◊uD��« s� b¹bF�« wGK¹ bOŠu²�« bFÐ

Æ qC�« tŽd�Ð

 WEŠö�

 ¡«dł« sJL¹ô t½ô p�–Ë ¨t� t½uJL�« d�UMFK� dOOGð Í√ ¡«dł« ÂbŽ s� b�Q²�« bFÐ ô« d�ô« «c¼ cOHMð r²¹ ô
Æ bOŠu²�« tOKLŽ ÂULð« bFÐ UHOHÞ ÊU� u�Ë q¹bFð Í√

d�ô« qLŽ tI¹dÞ

Union  bOŠu²�« d�« jA½≠±
ÆtDIM� Ëb³ð YO×Ð U¼bOŠuð b¹dð w²�« d�UMF�« jA½ ≠≤

Æ bOŠu²�« tOKLŽ ÂULðô sOL¹ Á—QH�« Ë«  Enter jG{« ≠≥

. https://www.wepal.net
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±≥≥

©∏∞® qJA�« d�UMŽ bŠË    ∫‰U¦�

∫q×�«

Union bOŠu²�« d�« jA½ – ±
Æ©∏±® qJA�« w� UL� tDIM� Ëb³ð ·uÝ ©∏∞® qJA�« d�UMŽ lOLł jA½ – ≤
Æ ©∏≤® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ sOL¹ Á—QH�« Ë«  Enter jG{« – ≥

bOŠu²�« bFÐ ∫©∏≤® qJý                 U¼bOŠuð œ«dL�« d�UMF�« ∫©∏±® qJý                  bOŠu²�« q³� ∫©∏∞® qJý

Æ©∏≥®qJý `D��« lOLł œUÝ Íc�« dCšô« ÊuK�« p�c�Ë bOŠu²�« bFÐ XH²š« w²�« ◊uD�K� dE½«

                             
bOŠu²�« bFÐ                               ©∏≥® qJý                                          bOŠu²�« q³� 

Intersect       lÞUI²�« d�«

Æd¦�U� sOL�ł lÞUIð s� ZðUM�« qJA�« u¼ lÞUI²�« d�«
∫qLF�« tI¹dÞ

ÆIntersect d�ô« jA½ – ±
ÆtDIM� Ëb³ð ·uÝ ¨UNFÞUIð ©rÝ—® ÃU²M²Ý« b¹dð w²�« d�UMF�« jA½ – ≤

ÆlÞUI²�« tOKLŽ ÂULðô sOL¹ Á—QH�« Ë√ Enter jG{« ≠≥

. https://www.wepal.net
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±≥¥

©∏¥® qJAK� lÞUI²�« tIDM� błË«     ∫ ‰U¦�

©∏¥® qJý

                                       
∫q×�«

Intersect           d�ô« jA½ ≠±
Æ©∏μ® qJA�« ¨dE½« tDIM� Ëb³ð ·uÝ t½«uDÝô«Ë VFJL�« jA½ ≠≤

ÆlÞUI²²�« tOKLŽ ÂULðô Á—QH�« sOL¹ vKŽ dI½« Ë« Enter j{« ≠≥
Æ©∏∂® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ

©∏∂® qJý                                                    ©∏μ® qJý

. https://www.wepal.net
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±≥μ

Extrude o¦³�« tI¹dDÐ bF³�« tOŁöŁ ÂU�łô ÂuÝ— ¡UA½«

 o¦³�« bŠ u¼ ŸUHð—« ÂuÝd�« ¡UDŽSÐ p�–Ë bF³�« tOŁöŁ ÂuÝ— ‰« bF³�« tOzUMŁ ÂuÝd�« q¹u×ð w¼ o¦³�« tI¹dÞ
∫UL¼Ë ÊUÞdý UNÐ d�u²¹ Ê« V−¹ bF³�« tOzUMŁ ÂuÝd�« o¦ÐË¨Á—«bI� Ë«

©◊uD��« lL−�Ë¨lKCL�«Ë¨Ádz«b�«Ë¨qOD²�L�«®  q¦� Polyline j��« ÊuJ¹ Ê« ≠±
Æ tI¦Ð sJL¹ vŠ UIKG� j��« ÊuJ¹ Ê« ≠≤

  Extrude       o¦³�« d�«
∫ ‰öš s� Solids tLzUI�« s� d�ô« «c¼ jOAMð sJL¹

Draw      Solids      Extrude

Æ Uł—œ ∑ t¹Ë«eÐË ∂∞ —«bI0 ©∏∑® qJý Ádz«b�« o¦Ð«      ∫ ©±® ‰U¦�

                        ∫ q×�«
Extrude    d�ô« jA½  ≠±

Select object tO�U²�« t�UÝd�« Ëb³ð U�bMŽ Ádz«b�« ©d²š«® jA½ ≠≤
Enter  jG{« ≠≥

  tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©∂∞® o¦³�« ŸUHð—« qšœ« ≠¥
Specify height of extrude or ›Path¤ ∫ 60©∏∑® qJý

  Enter j{« – μ
tO�U²�« t�UÝd�« ÂU�« ©∑® o¦³�« t¹Ë«“ qšœ« – ∂

Specify angle of taper for extrude <0> : 7

                                                                     ©∏∏® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ   Enter jG{« ≠∑

qOKE²�« bFÐ                                                                                             qOKE²�« q³� ∫©∏∏® qJý

. https://www.wepal.net
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±≥∂

∫ ©≤® ‰U¦�

μ∞ —«bILÐ tI¦Ð« rŁ Polyline  d�« tDÝ«uÐ ©∏π® qJA�« rÝ—«

©∏π® qJý

 ∫ q×�«

                                              Extrude    d�ô« jA½ – ±
Select objects ∫tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©∏π® qJA�« jA½ ≠≤

©π∞® qJA�« w� u¼ UL� jIM� oÐU��« qJA�« dNEOÝ
   Enter jG{«– ≥

∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©μ∞® o¦³�« ŸUHð—« ŸUHð—« qšœ« ≠¥
                                                     Specify height of extrude or ›path¤ ∫ 50  

Enter  jG{« – μ©π∞® qJý

∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©∞® o¦³�« t¹Ë«“ qF−� tO½UŁ Ád� Enter  jG{«≠∂
Specify angle of taper for extrusion :<0>

Enter  jG{«≠∑
©π±®  qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ

©π±®  qJý

. https://www.wepal.net
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±≥∑

Sections    UŽUDI�« ¡UA½«

∫ UL¼Ë sO²I¹dDÐ r²¹ AutoCAD  w�  UŽUDI�« rÝ—
   Slice  d�ôUÐ p�–Ë s¹√eł v�« tKB�Ë ©r�−L�«® rÝd�« lD� ≠±

Section    d�ôUÐ p�–Ë hI�« Èu²�L� jI�� rÝ— ≠≤

Slice  d�ô«

∫ tLzU� v�« »U¼c�UÐ Ë«¨ ÁdýU³�  Solids  «Ëœ« j¹dý s� Slice d�ô« jOAMð r²¹
                                  Draw      Solids      Slice

∫ d�ô« qLŽ tI¹dÞ

Slice       d�ô« jA½ ≠±
                     Select  objects ∫tO�U²�« t�UÝd�« Ëb³ð U�bMŽ tFD� b¹dð Íc�« dBMF�« d²š« ≠≤

 Enter jG{« – ≥
∫tO�U²�« t�UÝd�« Ëb³ð U�bMŽ r�−L�« vKŽ ◊UI½ tŁöŁ b¹b×²Ð p�–Ë lDI�« Èu²�� d²š« ≠¥

Specify first point on slicing plane by  

[Object/Zaxis/View/XY/YZ/ZX/3POIN] <3Points>  

Æ 5zeł v�« ©π≤® qJý —uEM*« lD�«   ∫‰U¦�

©π≤® qJý

∫ q×�«

  Slice       d�ô« jA½ – ±
Select  objects : tO�U²�« t�UÝd�« Ëb³ð U�bMŽ ©t�bI²�® tDA½ Ëb³ð ·uÝ t�u−L�« t½«uDÝô« d²š« – ≤

. https://www.wepal.net
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±≥∏

Æ—UO²šô« ¡UN½ô   Enter  j{« – ≥
∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ lDI�« Èu²�L� v�Ëô« tDIM�« œbŠ – ¥

Specify first point on slicing plane by  

[Object/Zaxis/View/XY//YZ/ZX/3points]  

∫ tO�U²�« t�UÝd�« Ëb³ð U�bMŽ lDI�« Èu²�L� tO½U¦�« tDIM�« œbŠ – μ
Specify second point on point∫  

∫tO�U²�« t�UÝd�« Ëb³ð U�bMŽ lDI�« Èu²�L� t¦�U¦�« tDIM�« œbŠ ≠∂
Specify third point on plane∫  

              
lDI�« Èu²�L� t¦�U¦�« tDIM�« lDI�« Èu²�L� tO½U¦�« tDIM�« lDI�« Èu²�L� v�Ëô« tDIM�«

©π≥® qJý

∫t�UÝd�«  Ác¼ bMŽ Á—uNþ b¹dð Íc�« lDI�« Èu²�� ©V½Uł® tNł vKŽ Á—QH�UÐ dI½« ≠∑
 Specify point on desired side of the plane or [Keep Both side]:  

Æ©π¥® qJý w� UL� pLÝ— Ëb³¹ ·uÝ

dIM�« bFÐ qJA�«

 tOKLŽ cOHM²� UM¼ dI½«
«cNÐ ÿUH²Šô«Ë lDI�«

¡e−�«

dIM�« q³� qJA�«
©π¥® qJý

. https://www.wepal.net
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±≥π

       cOHMð ÈuÝ pOKŽ UL� © π¥® qJA�« w� UL� sOŽuDIL�« sOze−�UÐ ÿUH²Šô«  —d� «–« U�«
Æ ©∏® r�— ÁuD�K� ÁdýU³� ‰UI²½ô«Ë ©∑® r�— ÁuD��«

∫tO�U²�« t�UÝd�« dNEð U�bMŽ Both tLK� s� ‰Ëô« ·d×�« u¼Ë ©B® ·d×�« V²�« – ∏
     Specify a point on desired side of the plane or [Keep Both sides]: B  

Æ ©πμ® qJA�« w� UL� pLÝ— Ëb³¹ ·uÝ
                                      

sOzeł v�« tKB� rð b�Ë r�−L�« ∫©πμ® qJý

                                                                
 ·uÝ öOK� t�dŠË Ã–uLM�« wzeł bŠ« d²š« ©  Move ® p¹d×ð d�ô« jA½

 Æ ©π∂®  qJA�« w� UL� pLÝ— Ëb³¹

ULNKB� bFÐ tOzeł p¹d×ð rð b�Ë r�−L�« ∫©π∂® qJý

 WEŠö�

Æ©π∑®qJA�« w� UL� »uKDL�« ¡e−�« vI³¹ dEM�« tNł s� ¡e−�« t�«“« bFÐ 

©π∑® qJý

. https://www.wepal.net
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±¥∞

lł«dL�« WLzU�

∫WOÐdF�« lł«d*«      

 Æ≤∞∞¥ ¨l¹“u²�«Ë dAMK� ‚ËdA�« —«œ ∫ÊULŽ Æ≤◊ ¨wÝbMN�« rÝ— w� lłd*« ¨`�U� œuL×� Æœ ¨◊uLŽ“  ±
 Æ±πππ ¨l¹“u²�«Ë dAM�«Ë WŽU³DK� U¹œU½ ∫tK�« Â«— ¨wÝbMN�« rÝd�« ΔœU³� ¨vO×¹ ¨WOC�  ≤

 Æa¹—Uð ÊËbÐ ¨WOF�U'« Vð«d�« —«œ ∫ ËdOÐ ¨wÝbMN�« rÝd�« ΔœU³� ¨s¹b�« w×� Æœ ¨ÊöAI�«  ≥
 Æ≤∞∞¥ ¨l¹“u²�«Ë dAMK� ¡UH� —«œ ∫ÊULŽ ¨≤◊ ¨wÝbMN�« rÝd�« ¨Í“u� ¨—u�«  ¥

 Æ≤∞∞∞ ¨W�dF*« ÊU²�Ð ∫—«Ëb�« dH� ¨±◊ ¨±Ã wÝbMN�« rÝd�« ¨bOL(« b³Ž ¨dJý  μ
Æ ±π∏∑ wŽUMB�« rÝd�«       wKÐuF�« ÷uŽ ÆÂ ¨ Í—«u(« w×²� ÆÂ ¨ w½öOJ�« ÊULOKÝ Æ Â  ∂

∫WO³Mł_« lł«d*«       

 1    Frederick E. Giesecke & others, Technical Drawing, 2th ed. Prentice Hall, 2003. 

 2    Jackson E, Advanced Level Technical Drawing, 3ed. London: Longman Group Ltd., 1975. 
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